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ลักษณะรายวิชา
หลักสูตร ประกาศนียบัตรวิชาชีพ.

ประเภทวิชาอุตสาหกรรมดิจิทัลและเทคโนโลยีสารสนเทศ
กลุ่มอาชีพธุรกิจดิจิทัลและพาณิชย์อิเล็กทรอนิกส์

สาขาวิชา เทคโนโลยีธุรกิจดิจิทัล
รหัส 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ

ทฤษฎี 1 ช่ัวโมง/สัปดาห์ ปฏิบัติ 2 ช่ัวโมง/สัปดาห์ จํานวน 2 หน่วยกิต
อ้างอิงมาตรฐาน

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
ผลลัพธ์การเรียนรู้ระดับรายวิชา

ใช้งานโปรแกรมตารางคํานวณ คํานวณ สร้างรายงานในรูปแผนภูมิและตารางวิเคราะห์ข้อมูล ด้วยความ
ละเอียด รอบคอบ
จุดประสงค์รายวิชา เพื่อให้

1. เข้าใจหลักการทํางานของโปรแกรมตารางคํานวณ
2. มีทักษะในการใช้งานโปรแกรมตารางคํานวณ ในการจัดรูปแบบ ปรับแต่งข้อมูล แทรกวัตถุ ในแผ่นงาน ใช้
สูตรฟงัก์ชันเพื่อการคํานวณ การส่ังพิมพ์แผ่นงาน และการป้องกันแผ่นงาน
3. มีความสามารถประยุกต์ใช้โปรแกรมตารางคํานวณในงานอาชีพ
4. มีเจตคติและกิจนิสัยท่ีดีในการปฏิบัติงานคอมพิวเตอร์ด้วยความละเอียด รอบคอบ

สมรรถนะรายวิชา
1. แสดงความรู้เก่ียวกับการทํางานของโปรแกรมตารางคํานวณตามหลักการ
2. ใช้โปรแกรมตารางคํานวณ ในการจัดรูปแบบ ปรับแต่งข้อมูล แทรกวัตถุในแผ่นงาน ใช้สูตรฟังก์ชัน เพื่อ
การคํานวณ การส่ังพิมพ์แผ่นงาน และการป้องกันแผ่นงานตามหลักการและกระบวนการ
3. จัดทํารายงานในรูปแผนภูมิและตารางวิเคราะห์ข้อมูลตามหลักการและกระบวนการ
4. วิเคราะห์ข้อมูลเชิงลึกในงานธุรกิจดิจิทัลตามหลักการและกระบวนการ
5. ประยุกต์ใช้โปรแกรมตารางคํานวณในงานอาชีพ

คําอธิบายรายวิชา
ศึกษาและปฏิบัติเก่ียวกับการใช้งานโปรแกรมตารางคํานวณ ในการจัดการตารางคํานวณ ปรับแต่ง ข้อมูลใน

แผ่นงาน จัดรูปแบบข้อมูลในแผ่นงาน พิมพ์แผ่นงาน ใช้สูตรฟังก์ชันเพื่อการคํานวณ แทรกวัตถุ ลงบนแผ่นงาน
การป้องกันแผ่นงาน การวิเคราะห์ข้อมูลเชิงลึก (Data Analytics) และประยุกต์ใช้เครื่องมือ ในการสร้างรายงาน
ในรูปแผนภูมิและตารางวิเคราะห์ข้อมูล (Pivot Table)



มาตรฐานอาชีพ (ถ้ามี)
หน่วยงานรับรองมาตรฐานอาชีพ หน่วยงานสถาบันคุณวุฒิวิชาชีพ (องค์กรมหาชน)

มาตรฐานอาชีพ สาขาวิชาเทคโนโลยีธุรกิจดิจิทัล
สมรรถนะสนับสนุนการทํางานด้านการใช้ดิจิทัล ระดับ 2และระดับ 3

หน่วยสมรรถนะ สมรรถนะย่อย เกณฑ์การ
ปฏิบัติงาน

วิธี
ประเมินรหัส คําอธิบาย รหัส คําอธิบาย

2001 ใช้โปรแกรม
ประมวลผล
คํา

20011 1. จั ด ก า ร ง า น เ อ ก ส า ร (Manage
Document)

1.1 บ ริ ห า ร
จัดการเอกสารได้
1.2 ต้ังค่ามุมมอง
ขอ ง เอกส าร ไ ด้
1.3 ค้ นห า แล ะ
แทนท่ีข้อความใน
เอกสาร ได้ 1.4
ย้าย คัดลอกและ
วาง ข้อความใน
เอกสาร ได้ 1.5
ยกเลิกการกระทํา
(Undo) ใ น
เอกสารได้

ข้ อ ส อบ
ข้อเขียน

20012 จัดรูปแบบข้อความ (Format Text in
Document)

2.1 ป รั บ แ ต่ ง
รูปแบบตัวอักษร
ในเอกสารได้
2.2 ใช้สไตล์เพื่อ
จั ด รู ป แ บ บ
ตั ว อั ก ษ ร ใ น
เอกสารได้
2.3 แ ท ร ก
สัญลักษณ์แสดง
หั ว ข้ อ ย่ อ ย ใ น
เอกสารได้

ข้ อ ส อบ
ข้อเขียน

20013 จัดการกับย่อหน้าในเอกสาร (Format
Paragraph)

3.1 จั ด รู ปแบบ
ย่อหน้าเอกสารได้
3.2 ใช้ชุดรูปแบบ
(Theme) เ พื่ อ
ปรับแต่งเอกสาร
ได้
3.3 แ บ่ ง ส่ ว น

ข้ อ ส อบ
ข้อเขียน



เอกสารได้
20014 แทรกวัตถุลงบนงานเอกสาร (Insert

Object to Document)
4.1 แทรกวัตถุใน
เอกสารได้
4.2 ป รั บ แ ต่ ง
วัตถุในเอกสารได้
4.3 แทรกตาราง
ในเอกสารได้
4.4 ป รั บ แ ต่ ง
ตารางในเอกสาร
ได้

ข้ อ ส อบ
ข้อเขียน

20015 จั ด รู ป แ บ บ เ อ ก ส า ร (Format
Document)

5.1 ตั้ ง ค่ า
หน้ากระดาษได้
5.2 จั ด ว า ง
ข้ อ ค ว า ม ใ น
หน้ากระดาษได้
5.3 แ ท ร ก หั ว
กระดาษและท้าย
กระดาษได้

ข้ อ ส อบ
ข้อเขียน

20016 พิมพ์เอกสาร (Printing Document) 6.1 ต้ั ง ค่ า ก า ร
พิมพ์ เอกสารได้
6.2 แ ส ด ง
ตัวอย่างก่อนพิมพ์
เ อกสาร ได้ 6.3
สั่งพิมพ์เอกสารได

ข้ อ ส อบ
ข้อเขียน

20017 ต ร ว จ ท า น ง า น เ อ ก ส า ร (Review
Document)

7.1 ต ร ว จ ส อบ
แ ก้ ไ ข คํ า ส ะ ก ด
และไวยากรณ์ได้
7.2 ต ร ว จ ส อบ
สถิติจํานวนคําได้
7.3 จํ า กั ด ก า ร
แก้ไขเอกสารได้

ข้ อ ส อบ
ข้อเขียน



มาตรฐานอาชีพ (ถ้ามี)
หน่วยงานรับรองมาตรฐานอาชีพ หน่วยงานสถาบันคุณวุฒิวิชาชีพ (องค์กรมหาชน)

มาตรฐานอาชีพ สาขาวิชาเทคโนโลยีธุรกิจดิจิทัล
สมรรถนะสนับสนุนการทํางานด้านการใช้ดิจิทัล ระดับ 2และระดับ 3

หน่วยสมรรถนะ สมรรถนะย่อย เกณฑ์การ
ปฏิบัติงาน

วิธีประเมิน
รหัส คําอธิบา

ย
รหัส คําอธิบาย

200
2

ช้โปรแกร
มต าร า ง
คํานวณ

20021 จั ด ก า ร ต า ร า ง คํ า น ว ณ (Manage
Spreadsheet)

1.1 จัดการแผ่น
งานได้
1.2 จั ด ก า ร
เซลล์ แถวและ
คอลัมน์ได

ข้ อ ส อ บ
ข้อเขียน

20022 ปรับแต่ งข้อมูลในแผ่นงาน (Manage
Row & Column)

2.1 ป้อนข้อมูล
ลงในแผ่นงานได้
ย้าย คัดลอกและ
วาง ข้อความใน
แผ่นงานได้ 2.3
กรองข้ อมู ล ใน
แผ่นงานได้
2.4 เรียงลําดับ
แผ่นงานได้

ข้ อ ส อ บ
ข้อเขียน

20023 จัดรูปแบบข้อมูลในแผ่นงาน (Format
Cell & Worksheet)

3.1 จัดรูปแบบ
ข้ อ มู ล ใ น แ ผ่ น
งานได้
3.2 ใช้เครื่องมือ
อั ต โ น มั ติ เ พื่ อ
จัดรูปแบบข้อมูล
ในแผ่นงานได

ข้ อ ส อ บ
ข้อเขียน

20024 พิมพ์แผ่นงาน (Printing Worksheet 4.1 ตั้ ง ค่ า ก า ร
พิมพ์แผ่นงานได้
4.2 แ ส ด ง
ตั ว อ ย่ า ง ก่ อ น
พิมพ์แผ่นงานได้
4.3 สั่ ง พิ ม พ์
แผ่นงานได้

ข้ อ ส อ บ
ข้อเขียน

20025 ใ ช้ สู ต ร ฟั ง ก์ ชั น เ พื่ อ ก า ร คํ า น ว ณ
(Functions, Formulas, and

5.1 ใ ช้ สู ต ร
(Formula) เพื่ อ ข้ อ ส อ บ

ข้อเขียน



Operators) คํานวณได้ 5.2
ใ ช้ ฟั ง ก์ ชั น
(Function) เพื่อ
คํานวณได้

20026 แทรกวัตถุลงบนแผ่นงาน (Insert Object
to Spreadsheet)

6.1 แทรกวัตถุ
ในแผ่ น งาน ได้
6.2 ป รั บ แ ต่ ง
วัตถุในแผ่นงาน
ได้

ข้ อ ส อ บ
ข้อเขียน

20027 ป้องกันแผ่นงาน (Protect Worksheet) 7.1 ป้ อ ง กั น
แผ่นงานได้ 7.2
ต้ังค่าแผ่นงานให้
อ ยู่ ใ น ส ถ า น ะ
ข้ันตอนสุดท้าย
ได้

ข้ อ ส อ บ
ข้อเขียน



มาตรฐานอาชีพ (ถ้ามี)
หน่วยงานรับรองมาตรฐานอาชีพ หน่วยงานสถาบันคุณวุฒิวิชาชีพ (องค์กรมหาชน)

มาตรฐานอาชีพ สาขาวิชาเทคโนโลยีธุรกิจดิจิทัล
สมรรถนะสนับสนุนการทํางานด้านการใช้ดิจิทัล ระดับ 2และระดับ 3

หน่วยสมรรถนะ สมรรถนะย่อย เกณฑ์การปฏิบัติงาน วิธีประเมิน
รหัส คําอธิบาย รหัส คําอธิบาย

2003 ใช้โปรแกรม
นําเสนอ

20031 จัดการงานนําเสนอ (Create
and Manage Slides)

1.1 สร้างงานนําเสนอ
ใหม่ได้
1.2 จั ดการ มุมมอง
ให้กับงานนําเสนอได้
1.3 ใช้เค้าโครงให้กับ
งานนําเสนอได

ข้ อ ส อ บ
ข้อเขียน

20032 ใช้ งานข้ อความบนสไลด์
(Format Text in Slides)

2.1 จั ด รู ป แ บ บ
ข้ อ ค ว า ม ใ น ง า น
นําเสนอได้
2.2 แทรกสัญลักษณ์
แสดงหั ว ข้อย่อยใน
งานนําเสนอได

ข้ อ ส อ บ
ข้อเขียน

20033 แทรกวัตถุลงบนงานนําเสนอ
(Insert Object to
Presentation)

3.1 แทรกวัตถุในงาน
นํ า เ ส น อ ไ ด้ 3.2
ปรับแต่งวัตถุในงาน
นําเสนอได้

ข้ อ ส อ บ
ข้อเขียน

20034 กํ า ห น ดก า ร เ ค ลื่ อ น ไ ห ว
(Configure Animations
and Slide Transitions)

4.1 ต้ั ง ค่ า ก า ร
เคล่ือนไหวให้กับวัตถุ
ในงานนําเสนอได้
4.2 ตั้งค่าการเปล่ียน
ส ไ ล ด์ ใ ห้ กั บ ง า น
นําเสนอได

ข้ อ ส อ บ
ข้อเขียน

20035 ต้ังค่างานนําเสนอ (Setup
Slide Show)

5.1 เ ลื อ ก ส ไ ล ด์ ท่ี
ต้องการนําเสนอได้
5.2 ตั้ ง ค่ า ก า ร
นําเสนอสไลด์ได้ 5.3
นําเสนอสไลด์ได้

ข้ อ ส อ บ
ข้อเขียน



ตารางวิเคราะห์พฤติกรรมการเรียนรู้

หน่วยการเรียนรู้

ความสามารถท่ีคาดหวัง

รวม
จํานวน
ช่ัวโมง
ท/ป

พุทธิพิสัย

ทักษะ
พิสัย

จิต
พิสัย

ประยุกต์
ใช้

คว
าม

รู้

คว
าม

ข้า
ใจ

กา
รน

ําไ
ปใ

ช้

กา
รวิ

เค
รา

ะห์

กา
รป

ระ
เม

ินค่
า

กา
รส

ร้า
งส

รร
ค์

1.ลั ก ษณ ะพื้ น ฐ า น ข อ ง
โปรแกรมตารางงาน

1 1 1 1 - - 2 2 - 8 4

2.ก า ร ป้ อ น แ ล ะ จั ด เ ก็ บ
ข้อมูล

1
1

1 1 - - 2 2 - 8 4

3.การแก้ ไ ขและตกแ ต่ ง
ข้อมูล

1
1

2 1 - - 2 2 - 9 8

4.การสร้างตารางข้อมูล 1 1 2 1 1 1 2 2 - 11 8
5.การใช้สูตรและฟังก์ชันใน
การคํานวณ

1 1 2 2 1 1 2 2 - 12 8

6.การเรียงลําดับ 1 1 1 1 1 - 2 2 - 9 8
7.การสรุ ปและนํ า เสนอ
ข้อมูลในรูปแผนภูมิ

1
1

2 1 1 1 2 2 - 11 8

8.การสรุ ปและนํ า เสนอ
ข้อมูลในรูปตารางวิเคราะห์
ข้อมูล

1
1

2 1 1 1 2 2
-

11 8

9.การพยากรณ์ข้อมูล 1 1 2 1 1 1 2 2 - 11 8
10.การใช้คําสั่งแมโครและ
การพิมพ์เอกสารออกทาง
เครื่องพิมพ์

1
1

2 1 1 - 2 2
-

10
8

รวม 10 10 17 11 7 5 20 20 - 100 72

ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา (เม่ือเรียนรายวิชานี้สําเร็จแล้วทําอะไรได้)

รวมท้ังรายวิชา 72



หน่วยการเรียนรู้

หน่วย
ท่ี

หน่วยการเรียนรู้
เวลาเรียน (ชม.)

ทฤษฎี ปฏิบัติ รวม
1 ลักษณะพ้ืนฐานของโปรแกรมตารางงาน 2 2 4

2 การป้อนและจัดเก็บข้อมูล 2 2 4

3 การแก้ไขและตกแต่งข้อมูล 4 4 8

4 การสร้างตารางข้อมูล 4 4 8

5 การใช้สูตรและฟังก์ชันในการคํานวณ 4 4 8

6 การเรียงลําดับ 4 4 8

7 การสรุปและนําเสนอข้อมูลในรูปแผนภูมิ 4 4 8

8 การสรุปและนําเสนอข้อมูลในรูปตารางวิเคราะห์ข้อมูล 4 4 8

9 การพยากรณ์ข้อมูล 4 4 8

10 การใช้คําสั่งแมโครและการพิมพ์เอกสารออกทางเครื่องพิมพ์ 4 4 8

ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา 36 36 72

รวม 72

การประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา : หลักสูตร ปวช. สัปดาห์ท่ี 18, หลักสูตร ปวส. สัปดาห์ท่ี 15



แผนการจัดการเรียนรู้ หน่วยที่ 1
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 1-2

ช่ือหน่วยการเรียนรู้ ลักษณะพ้ืนฐานของโปรแกรมตารางงาน
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน ลักษณะพ้ืนฐานของโปรแกรมตารางงาน

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1. วิวัฒนาการของระบบจํานวนและตัวเลข
2. โครงสร้างของระบบจํานวน
3. จํานวนจริง
4. จํานวนเต็ม
5. จํานวนธรรมชาติ
6. จํานวนตรรกยะ
7. จํานวนอตรรกยะ
8. การคํานวณทางคณิตศาสตร์ของจํานวนจริง

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
1. แสดงความรู้เก่ียวกับระบบจํานวนในเรื่องของคุณสมบัติของจํานวนต่าง ๆ
2. คํานวณเก่ียวกับการบวก การลบ การคูณ และการหารของจํานวนจริง

4. จุดประสงค์เชิงพฤติกรรม
1. รู้จักโครงสร้างของระบบ
2. จําแนกจํานวนแต่ละชนิดได้
3. ทําการคํานวณเบื้องต้นได้

5. สาระการเรียนรู้
1. วิวัฒนาการของระบบจํานวนและตัวเลข
2. โครงสร้างของระบบจํานวน
3. จํานวนจริง
4. จํานวนเต็ม
5. จํานวนธรรมชาติ
6. จํานวนตรรกยะ
7.จํานวนอตรรกยะ
8.การคํานวณทางคณิตศาสตร์ของจํานวนจริง



6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0
50-54 1
55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%



8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 1 หน่วยที่ 1
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 1-2

ช่ือหน่วยการเรียนรู้ ลักษณะพ้ืนฐานของโปรแกรมตารางงาน
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน ลักษณะพ้ืนฐานของโปรแกรมตารางงาน

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
การศึกษาวิชาน้ีเป็นวิชาท่ีเน้นผู้เรียนเป็นสําคัญ เพื่อปลูกฝังให้พัฒนาตนเองเข้าสู่อาชีพอย่างสม่ําเสมอ

และนําไปประยุกต์การใช้คอมพิวเตอร์เพื่อวางแผนใช้ในการทํางานสําหรับชีวิตประจําวันต่อไป และยังเป็นการให้
ผู้เรียนได้มีโอกาสฝึกทักษะความชํานาญการเรียนรู้ด้านความรู้ ความสามารถพ่ือมีส่วนร่วมในการเรียนอย่างเต็มท่ี
ในการฝึกทักษะการปฏิบัติจริง เพ่ือพัฒนาทักษะ ความรู้ และความสามารถรวมทั้งสติปัญญาเพื่อแก้ปัญหาได้
ผู้เรียนวิชานี้นอกจากจะได้ความรู้ที่ถูกต้องแล้วยังสามารถนําไปประยุกต์ใช้ในงานเพื่อเป็นเคร่ืองมือที่สําคัญในการ
เพิ่มประสิทธิภาพของงาน และสามารถแก้ปัญหาในชีวิตประจําวันอีกด้วย

โปรแกรม Microsoft Excel 2016 เป็นโปรแกรม หนึ่งในชุด Microsoft Excel 2016 หรือชุดโปรแกรม
สํานักงานพัฒัชนาโดยบริษัทไมโครซอฟท์คอร์ปอเรชัน จํากัด โปรแกรม Microsoft Excel 2016 เป็นโปรแกรม
สําหรับงานที่เกี่ยวกับการคํานวณตัวเลขโดยลักษณะการคํานวณน้ันเป็นไปในรูปแบบของสเปรดชีต (Spread
sheet) อาศัยตารางการคํานวณท่ีเป็นช่อง ๆ ซ่ึงเรียกว่า “เซลล์” (Cell) รวมทั้งการวิเคราะห์ข้อมูลการสร้างตาราง
ในรูปแบบต่าง ๆ การสร้างแผนภูมิ แผนผัง การวิเคราะห์ข้อมูลตลอดจน พัฒนาให้เป็นระบบงานที่มีขีด
ความสามารถสูงมีการ วิเคราะห์ข้อมูลและพัฒนาระบบฐานข้อมูลได้อย่างมีประสิทธิภาพ

นอกจากน้ีโปรแกรม Microsoft Excel 2016 ยังมีความสามารถในการทํางานร่วมกับโปรแกรมอื่น ๆ เช่น
สามารถสร้างงานในรูปแบบของการนําเสนอ (Presentation) โดยสร้างให้อยู่ในรูปแบบของเว็บเพจ (Web Page)
ได้เป็นอย่างดี
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

1.แสดงความรู้เก่ียวกับระบบจํานวนในเรื่องของคุณสมบัติของจํานวนต่าง ๆ
2.คํานวณเก่ียวกับการบวก การลบ การคูณ และการหารของจํานวนจริง

4. จุดประสงค์เชิงพฤติกรรม
1.รู้จักโครงสร้างของระบบ
2.จําแนกจํานวนแต่ละชนิดได้
3.ทําการคํานวณเบื้องต้นได้

5. เน้ือหาสาระ
ลักษณะพ้ืนฐานของโปรแกรมตารางงาน
คุณสมบัติท่ัวไปของโปรแกรม Microsoft Excel 2016

โปรแกรม Microsoft Excel 2016 เ ป็นโปรแกรมห น่ึง ใน ชุด
Microsoft Excel 2016 หรือชุดโปรแกรมสํานักงาน พัฒนาโดย
บริษัท ไมโครซอฟท์ คอร์ปอเรชั่น จํากัด เป็นสุดยอดโปรแกรมสําหรับ
การคํานวณซึ่งผู้ใช้สามารถจัดเก็บ ปรับปรุง และวิเคราะห์ข้อมูลใน
ตารางเพ่ือใช้ในงานธุรกิจและงานท่ัวไปได้



การเรียกใช้โปรแกรม Microsoft Excel 2016
วิธีที่ 1 คลิกเมาส์ท่ีปุ่ม ท่ีทาสก์บาร์ และเลือกคลิกที่ Excel 2016 ดังภาพ
วิธีที่ 2 คลิกเลือกท่ีไอคอน Shortcut บนหน้าจอ Desktop โดยดับเบิลคลิกท่ีรูป

ส่วนประกอบหน้าจอของ Microsoft Excel 2016
Microsoft Excel 2016

มีลักษณะใกล้เคียงกับ Microsoft Excel 2010 แตกต่างกันในส่วนของความสามารถท่ีเพิ่มข้ึน มีการจัด
Interface ที่ดีข้ึน ใช้งานร่วมกับเว็บเบราว์เซอร์ โดยเปิดและแก้ไขข้อมูลในโปรแกรมผ่านเว็บเบราว์เซอร์ได้ทันที
สามารถทํางานร่วมกับการบริการ Cloud โปรแกรมใช้ได้กับเครื่องคอมพิวเตอร์ โน้ตบุ๊ก แท็บเล็ต สมาร์ตโฟน หรือ
อุปกรณ์หน้าจอสัมผัสได้

โปรแกรมสามารถวิเคราะห์และนําเสนอข้อมูลในรูปแบบใหม่ที่เข้าใจง่ายขึ้น เช่น Analysis Toolpak,
Slicer และ Format Builder ทําให้ประหยัดเวลาในการทํางาน สามารถแชร์ข้อมูลผ่านอินเทอร์เน็ตลักษณะและ
รายละเอียดส่วนประกอบหน้าจอของ Microsoft Excel 2016 มีดังนี้

1 File tab เป็นศูนย์รวมคําสั่งจัดการกับไฟล์ท่ัวไป เช่น Save, Open, New เป็นต้น
2 Quick Access Toolbar (แถบเครื่องมือด่วน) เป็นปุ่มคําสั่งด่วนและคําสั่งสําคัญ ๆ ท่ีใช้เป็นประจํา

ผู้ใช้สามารถเพ่ิมหรือลดปุ่มคําสั่งได้ตามต้องการ



3 Title Bar (แถบช่ือเรื่อง) เป็นส่วนแสดงชื่อโปรแกรม ชื่อสมุดงานและประเภทของสมุดงาน
4 Menu Bar (แถบเมนู) เป็นส่วนแสดงกลุ่มของชุดคําสั่งต่าง ๆ ในการทํางานของโปรแกรม Microsoft

Excel 2016
5 Minimize Button ปุ่มสําหรับย่อหน้าจอ
6 Maximize Button ปุ่มสําหรับย่อ-ขยาย
7 Close Button ปุ่มสําหรับปิดโปรแกรม
8 Ribbon เป็นชุดของกลุ่มคําสั่งและปุ่มเครื่องมือต่าง ๆ โดยจัดเป็นกลุ่ม ๆ ตามการใช้งานให้ใช้ได้สะดวก

ยิ่งขึ้น
9 Active Cell (เซลล์ท่ีทํางานอยู่) เป็นส่วนแสดงการทํางานในขณะนั้นว่าทํางานอยู่ที่เซลล์ใด
10 Formula Bar (แถบสูตรคํานวณ) เป็นส่วนแสดงสูตรในการคํานวณ รวมท้ังแก้ไขหรือปรับเปลี่ยน

ข้อมูลในเซลล์
11 Scroll Bar (แถบเลื่อน) เป็นส่วนที่ใช้เลื่อนหน้าจอ ขึ้น-ลง หรือเลื่อนไปซ้าย-ขวาเพื่อย้ายไปดูข้อมูลบน

แผ่นงาน
12 Sheet Tab เป็นส่วนแสดงชื่อของแผ่นงานท่ีใช้งานอยู่ในสมุดงาน
13 Zoom เป็นเครื่องมือ ย่อ-ขยาย หน้าจอ

ส่วนประกอบของแผ่นงาน (Worksheet)

การใช้งานริบบอน (Ribbon)

โปรแกรมชดุ Microsoft

Excel 2016 ไดม้กีารใชง้าน

Ribbon ซึง่เป็นการจดักลุม่

ของชดุคาํสัง่แบ่งตาม

ประเภทของการใชง้าน



File ใช้ในการเข้าสู่ Backstage View เพื่อจัดการกับไฟล์งานต่าง ๆ เช่น การบันทึกไฟล์การ เปิด-ปิดไฟล์ และการ
พิมพ์งาน เป็นต้น

Home ประกอบด้วยกลุ่มคําส่ัง 7 กลุ่ม ได้แก่

กลุ่มท่ี 2.1 Clipboard (คลิปบอร์ด)
กลุ่มท่ี 2.2 Font (แบบอักษร)
กลุ่มท่ี 2.3 Alignment (การจัดแนว)
กลุ่มท่ี 2.4 Number (ตัวเลข)
กลุ่มท่ี 2.5 Styles (ลักษณะ)
กลุ่มท่ี 2.6 Cells (เซลล์)
กลุ่มท่ี 2.7 Editing (การแก้ไข)
3. แท็บ Insert (แทรก) ประกอบด้วยกลุ่มคําส่ัง 8 กลุ่ม ได้แก่

กลุ่มท่ี 3.1 Tables (ตาราง)
กลุ่มท่ี 3.2 Illustrations (ภาพประกอบ)
กลุ่มท่ี 3.3 Charts (แผนภูมิ)
กลุ่มท่ี 3.4 Sparklines (แผนภูมิขนาดเล็ก)



กลุ่มท่ี 3.5 Filter (ตัวคัดกรอง)
กลุ่มท่ี 3.6 Links (การเช่ือมโยง)
กลุ่มท่ี 3.7 Text (ข้อความ)
กลุ่มท่ี 3.8 Symbols (สัญลักษณ์และสมการทางคณิตศาสตร์)
4. แท็บ Page Layout (เค้าโครงหน้ากระดาษ) ประกอบด้วยกลุ่มคําส่ัง 5 กลุ่ม ได้แก่

กลุ่มท่ี 4.1 Themes (ชุดรูปแบบ)
กลุ่มท่ี 4.2 Page Setup (ตั้งค่าหน้ากระดาษ)
กลุ่มท่ี 4.3 Scale to Fit (ปรับพอดี)
กลุ่มท่ี 4.4 Sheet Options (ตัวเลือกของแผ่นงาน)
กลุ่มท่ี 4.5 Arrange (จัดเรียง)
5.แท็บ Formulas (สูตร) ประกอบด้วยกลุ่มคําส่ัง 4 กลุ่ม ได้แก่

กลุ่มท่ี 5.1 Function Library (ไลบรารีฟังก์ชัน)
กลุ่มท่ี 5.2 Defined Names (ชื่อที่กําหนด)
กลุ่มท่ี 5.3 Formula Auditing (ตรวจสอบสูตร)
กลุ่มท่ี 5.4 Calculation (การคํานวณ)
6.แท็บ Data (ข้อมูล) ประกอบด้วยกลุ่มคําส่ัง 5 กลุ่ม ได้แก่

กลุ่มท่ี 6.1 Get External Data (รับข้อมูลภายนอก)
กลุ่มท่ี 6.2 Connections (การเช่ือมต่อ)
กลุ่มท่ี 6.3 Sort & Filter (เรียงลําดับและกรอง)
กลุ่มท่ี 6.4 Data Tools (เครื่องมือข้อมูล)
กลุ่มท่ี 6.5 Outline (เค้าร่าง)
7.แท็บ Review (ตรวจทาน) ประกอบด้วยกลุ่มคําส่ัง 4 กลุ่ม ได้แก่

กลุ่มท่ี 7.1 Proofing (การพิสูจน์อักษร)
กลุ่มท่ี 7.2 Language (ภาษา)
กลุ่มท่ี 7.3 Comments (ข้อคิดเห็น)
กลุ่มท่ี 7.3 Comments (ข้อคิดเห็น)



8.แท็บ View (มุมมอง) ประกอบด้วยกลุ่มคําส่ัง 5 กลุ่ม ได้แก่

กลุ่มท่ี 8.1 Workbook Views (มุมมองสมุดงาน)
กลุ่มท่ี 8.2 Show (แสดง)
กลุ่มท่ี 8.3 Zoom (ย่อ/ขยาย)
กลุ่มท่ี 8.4 Window (หน้าต่าง)
กลุ่มท่ี 8.5 Macros (แมโคร)

การจัดการกับแถบเครื่องมือด่วน (Quick Access Toolbar)
การเพ่ิมแถบเครื่องมือด่วน
1. คลิกเลือกท่ีรูปแบบ (Customize Quick Access Toolbar)
2. เลือกคําสั่ง Toolbars (แถบเครื่องมือ) ท่ีต้องการ เช่น เลือกท่ี Spelling
3. ผลท่ีได้จากการเลือกแถบเครื่องมือ Spelling

การยกเลิกแถบเครื่องมือด่วน
1. คลิกขวา ท่ีต้องการยกเลิก
2. เลือกคําสั่ง Remove from Quick Access Toolbar

แท็บอื่น ๆ ท่ีเกิดจากการเรียกใช้งาน
รายละเอียดของแถบเครื่องมือ
1. แถบเคร่ืองมือรูปวาด (Drawing Toolbars) จะแสดงเม่ือผู้ใช้แทรกรูปภาพ (Insert>Picture)โดยอยู่ใน
รูปแบบของคําสั่งในเมนู Format (รูปแบบ) เป็นแถบเครื่องมือท่ีช่วยในการวาดภาพและตกแต่งช้ินงาน



2. แถบเคร่ืองมือข้อความศิลป์ (WordArt) จะแสดงเม่ือผู้ใช้แทรกตัวอักษรศิลป์ (Insert>WordArt) หรือแทรก
รูปร่าง (Insert>Shapes) ในรูปแบบของคําสั่งเมนู Format (รูปแบบ)เป็นแถบเครื่องมือท่ีช่วยสร้างข้อความศิลป์
และจัดการกับข้อความศิลป์รวมท้ังจัดการเก่ียวกับรูปร่าง

การสร้างสมุดงานใหม่ (New)
1. คลิกท่ี File tab เพื่อเข้าสู่ Backstage View
2. ท่ีหน้า Backstage View คลิกเลือก New และเลือก Blank workbook เพ่ือสร้าง
สมุดงานเปล่า
3. นอกจากนี้ยังสามารถสร้างสมุดงานใหม่ได้โดยการกด Ctrl+N

การบันทึกสมุดงาน (Save)
1. คลิกท่ี File tab เพื่อเข้าสู่ Backstage View

2. ท่ีหน้า Backstage View คลิกเลือก Save หรือ Save As

3. เม่ือตั้งชื่อสมุดงานแล้วให้คลิกท่ีปุ่ม Save จะเป็นการบันทึกสมุดงาน

4. นอกจากนี้ยังสามารถบันทึกสมุดงานได้โดยการใช้แถบเครื่องมือบันทึกที่อยู่บน Quick
Access Toolbar (ในกรณีท่ีมีการตั้งค่าไว้)

หรืออาจใช้การกดคีย์ลัด Ctrl+S

การปิดสมุดงานและการออกจากโปรแกรม (Close)
1. คลิกท่ี File tab เพื่อเข้าสู่ Backstage View
2. ท่ีหน้า Backstage View คลิกเลือก Close

3. สามารถบันทึกสมุดงานได้โดยการคลิกท่ี ซ่ึงอยู่มุมขวา
บนของ

โปรแกรม หรือ ใช้คีย์ลัด

4. นอกจากนี้ยังสามารถออกจากโปรแกรมได้ด้วยการใช้คีย์
ลัด Alt+F4



การเปิดสมุดงาน (Open)
1. คลิกท่ี File tab เพื่อเข้าสู่ Backstage View
2. ท่ีหน้า Backstage View คลิกเลือก Open หรือใช้

คีย์ลัด Ctrl+O
3. จะปรากฏ Dialog Box ขึ้นมาให้เลือกสมุดงานที่

ต้องการเปิดและคลิก Open

6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน

7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)
หนังสือเรียนวิชาโปรแกรมตารางคํานวณ

8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 1 หน่วยที่ 1
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 1-2

ช่ือหน่วยการเรียนรู้ ลักษณะพ้ืนฐานของโปรแกรมตารางงาน
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ืองลักษณะพ้ืนฐานของโปรแกรมตารางงาน

แบบฝึกหัด
จากโจทย์คําถาม จงเลือกคําตอบที่ถูกต้องท่ีสุด
1. การจัดการข้อมูล การคํานวณ การวิเคราะห์ข้อมูลในตาราง เป็นความสามารถของโปรแกรมใดในชุด
Microsoft

ก. Microsoft Excel
ข. Microsoft Word
ค. Microsoft PowerPoint
ง. Microsoft Access
จ. Microsoft Publisher

2. ข้อใดเป็นไอค่อน (Icon) ของโปรแกรม Microsoft Excel

ก.

ข.

ค.

ง.

จ.



จากภาพ ใช้ตอบคําถามข้อ 3-4
3. หมายเลข 1 คืออะไร

ก. เป็นศูนย์รวมคําสั่งจัดการกับไฟล์ท่ัวไป
ข. เป็นปุ่มคําสั่งด่วนและคําสั่งสําคัญ ๆ ท่ีใช้เป็นประจํา
ค. เป็นส่วนแสดงกลุ่มของชุดคําสั่งต่าง ๆ ในการทํางานของโปรแกรม
ง. เป็นชุดของกลุ่มคําสั่งและปุ่มเครื่องมือต่าง ๆ โดยจัดเป็นกลุ่ม ๆ ตามการใช้งาน
จ. เป็นส่วนแสดงสูตรในการคํานวณ รวมท้ังแก้ไขหรือปรับเปลี่ยนข้อมูลในเซลล์

4. หมายเลขใดเป็นส่วนท่ีแสดงชื่อของแผ่นงานที่ใช้งานอยู่ในสมุดงาน
ก. หมายเลข 1
ข. หมายเลข 2
ค. หมายเลข 3
ง. หมายเลข 4
จ. หมายเลข 5

จากภาพ ใช้ตอบคําถามข้อ 5-6

5. หมายเลขใดคือคอลัมน์ (Column)
ก. หมายเลข 1



ข. หมายเลข 2
ค. หมายเลข 3
ง. หมายเลข 4
จ. หมายเลข 5

6. หมายเลข 5 คืออะไร
ก. Name Box (กล่องชื่อเซลล์)
ข. Cell (เซลล์)
ค. Row (แถว)
ง. Column (คอลัมน์/สดมภ์)
จ. Formula Bar (แถบสูตรคํานวณ)

7. จากภาพ ขณะนี้ Active Cell ทํางานอยู่ที่ Cell ใด

ก. Cell A1
ข. Cell B1
ค. Cell F1
ง. Cell A4
จ. Cell F4

8. หากต้องการจัดการกับไฟล์งานต่าง ๆ เช่น การบันทึกไฟล์ การเปิด-ปิดไฟล์ การพิมพ์งาน ควรไปท่ีแถบเมนูใด
ก. File (ไฟล์)
ข. Home (หน้าแรก)
ค. Insert (แทรก)
ง. Formula (สูตร)
จ. Data (ข้อมูล)

9. ข้อใดไม่ใช่การทํางานของแถบเมนู Home (หน้าแรก)
ก. ใช้ในการจัดการข้อมูลในแผ่นงาน เช่น การคัดลอก การตัดข้อมูล เป็นต้น
ข. ใช้ในการกําหนดลักษณะของตัวอักษร เช่น ขนาด สีตัวอักษร เป็นต้น
ค. ใช้สําหรับกําหนดการเรียงของตัวอักษร เช่น ให้ตัวอักษรชิดขอบซ้ายหรืออยู่กึ่งกลางหน้ากระดาษ เป็น

ต้น
ง. ใช้ในการกําหนดรูปแบบของตัวเลข เช่นกําหนดให้เป็นเลขจํานวนเต็ม แสดงตัวเลขในรูปทศนิยม เป็นต้น
จ. ใช้ในการกําหนดลักษณะท่ัวไปของแผ่นงาน เช่น แบบอักษร สีของแผ่นงาน เป็นต้น

10. หากต้องการแก้ไขแบบอักษร (Font) ต้องไปท่ีแท็บใด
ก. File (ไฟล์)



ข. Home (หน้าแรก)
ค. Insert (แทรก)
ง. Page Layout (เค้าโครงหน้ากระดาษ)
จ. Formula (สูตร)



เฉลยข้อสอบ

ข้อท่ี เฉลย

1 เฉลยข้อ ก. Microsoft Excel
คําอธิบาย โปรแกรม Microsoft Excel 2016 เป็นโปรแกรมหน่ึงในชุด Microsoft หรือชุด
โปรแกรมสํานักงานพัฒนาโดยบริษัทไมโครซอฟท์ คอร์ปอเรช่ัน จํากัด เป็นสุดยอดโปรแกรมสําหรับ
การคํานวณซึ่งผู้ใช้สามารถจัดเก็บ ปรับปรุง และวิเคราะห์ข้อมูลในตารางเพ่ือใช้ในงานธุรกิจและ
งานทั่วไปได้

2 เฉลยข้อ ข.

คําอธิบาย
เป็นไอคอนของโปรแกรม Microsoft Word

เป็นไอคอนของโปรแกรม Microsoft PowerPoint

เป็นไอคอนของโปรแกรม Microsoft Access

เป็นไอคอนของโปรแกรม Microsoft Publisher
3 เฉลยข้อ ก. เป็นศูนย์รวมคําสั่งจัดการกับไฟล์ท่ัวไป

คําอธิบาย ส่วนประกอบหน้าจอของ Microsoft Excel 2016
ลักษณะและรายละเอียดส่วนประกอบหน้าจอของ Microsoft Excel 2016 มีดังนี้

(1) File tab เป็นศูนย์รวมคําสั่งจัดการกับไฟล์ท่ัวไป เช่น Save, open, New เป็นต้น
(2) QuickAccess Toolbar (แถบเครื่องมือด่วน) เป็นปุ่มคําสั่งด่วนและคําสั่งสําคัญ ๆ ที่ใช้เป็น
ประจํา ผู้ใช้สามารถเพ่ิมหรือลดปุ่มคําสั่งได้ตามต้องการ
(3) Title Bar (แถบช่ือเรื่อง) เป็นส่วนแสดงชื่อโปรแกรม ชื่อสมุดงานและประเภทของสมุดงาน
(4) Menu Bar (แถบเมนู) เป็นส่วนแสดงกลุ่มของชุดคําส่ังต่าง ๆ ในการทํางานของโปรแกรม



Microsoft Excel 2016 ซึ่งประกอบด้วย File, Home, Insert, Page Layout, Formulas, Data,
Review, View และ Power Pivot
(5) Minimize Button ปุ่มสําหรับย่อหน้าจอ
(6) Maximize Button ปุ่มสําหรับย่อ-ขยาย
(7) Close Button ปุ่มสําหรับปิดโปรแกรม
(8) Ribbon เป็นชุดของกลุ่มคําสั่งและปุ่มเครื่องมือต่าง ๆ โดยจัดเป็นกลุ่ม ๆ ตามการใช้งาน ให้ใช้
ได้สะดวกยิ่งข้ึน
(9) Active Cell (เซลล์ท่ีทํางานอยู่) เป็นส่วนแสดงการทํางานในขณะนั้นว่าทํางานอยู่ที่เซลล์ใด
(10) Formula Bar (แถบสูตรคํานวณ) เป็นส่วนแสดงสูตรในการคํานวณ รวมทั้งแก้ไขหรือ
ปรับเปลี่ยนข้อมูลในเซลล์
(11) Scroll Bar (แถบเลื่อน) เป็นส่วนที่ใช้เลื่อนหน้าจอ ขึ้น-ลง หรือเล่ือนไปช้า-ขวาเพ่ือย้ายไป ดู
ข้อมูลบนแผ่นงาน ในกรณีท่ีแผ่นงานมีขนาดใหญ่ไม่สามารถแสดงข้อมูลได้หมดในหน้าจอเดียวแถบ
เลื่อนนี้ มีทั้งแนวตั้งและแนวนอน
12) Sheet Tab เป็นส่วนแสดงชื่อของแผ่นงานท่ีใช้งานอยู่ในสมุดงาน
(13) Zoom เป็นเครื่องมือ ย่อ-ขยาย หน้าจอ

4 เฉลยข้อ ค. หมายเลข 3
คําอธิบาย ส่วนประกอบหน้าจอของ Microsoft Excel 2016

ลักษณะและรายละเอียดส่วนประกอบหน้าจอของ Microsoft Excel 2016 มีดังนี้

(1) File tab เป็นศูนย์รวมคําสั่งจัดการกับไฟล์ท่ัวไป เช่น Save, open, New เป็นต้น
(2) QuickAccess Toolbar (แถบเคร่ืองมือด่วน)เป็นปุ่มคําส่ังด่วนและคําส่ังสําคัญ ๆ ที่ใช้เป็น
ประจํา ผู้ใช้สามารถเพ่ิมหรือลดปุ่มคําสั่งได้ตามต้องการ
(3) Title Bar (แถบช่ือเรื่อง) เป็นส่วนแสดงชื่อโปรแกรม ชื่อสมุดงานและประเภทของสมุดงาน
(4) Menu Bar (แถบเมนู) เป็นส่วนแสดงกลุ่มของชุดคําส่ังต่าง ๆ ในการทํางานของโปรแกรม
Microsoft Excel 2016 ซึ่งประกอบด้วย File, Home, Insert, Page Layout, Formulas, Data,
Review, View และ Power Pivot
(5) Minimize Button ปุ่มสําหรับย่อหน้าจอ
(6) Maximize Button ปุ่มสําหรับย่อ-ขยาย



(7) Close Button ปุ่มสําหรับปิดโปรแกรม
(8) Ribbon เป็นชุดของกลุ่มคําส่ังและปุ่มเคร่ืองมือต่าง ๆ โดยจัดเป็นกลุ่ม ๆ ตามการใช้งานให้ใช้
ได้สะดวกยิ่งข้ึน
(9) Active Cell (เซลล์ท่ีทํางานอยู่) เป็นส่วนแสดงการทํางานในขณะนั้นว่าทํางานอยู่ที่เซลล์ใด
(10) Formula Bar (แถบสูตรคํานวณ) เป็นส่วนแสดงสูตรในการคํานวณ รวมทั้งแก้ไขหรือ
ปรับเปลี่ยน ข้อมูลในเซลล์
(11) Scroll Bar (แถบเลื่อน) เป็นส่วนที่ใช้เลื่อนหน้าจอ ขึ้น-ลง หรือเล่ือนไปช้า-ขวาเพ่ือย้ายไป ดู
ข้อมูลบนแผ่นงาน ในกรณีท่ีแผ่นงานมีขนาดใหญ่ไม่สามารถแสดงข้อมูลได้หมดในหน้าจอเดียวแถบ
เลื่อนนี้ มีทั้งแนวตั้งและแนวนอน
12) Sheet Tab เป็นส่วนแสดงชื่อของแผ่นงานท่ีใช้งานอยู่ในสมุดงาน
(13) Zoom เป็นเครื่องมือ ย่อ-ขยาย หน้าจอ

5 เฉลยข้อ ง. หมายเลข 4
คําอธิบาย

1. Name Box (กล่องชื่อเซลล์) เป็นส่วนแสดงชื่อเซลล์ท่ีทํางานอยู่ขณะนั้น
2. Cell (เซลล์) เป็นส่วนท่ีใช้ในการอ้างอิง โดยเป็นส่วนของ Column และ Row ตัดกัน
3. Row (แถว) เป็นส่วนแสดงพ้ืนท่ีในแผ่นงานตามแนวนอนโดยมีจํานวนแถวท้ังหมด

1,048,576 แถว
4. Column (คอลัมน์/สดมภ์) เป็นส่วนแสดงพ้ืนที่ในแผ่นงานตามแนวต้ัง โดยมีจํานวน

คอลัมน์ท้ังหมด 16,384 คอลัมน์ ตั้งแต่คอลัมน์ A ถึงคอลัมน์ XFD
5. Formula Bar (แถบสูตรคํานวณ) เป็นส่วนแสดงสูตรในการคํานวณรวมทั้งแก้ไขหรือ

ปรับเปลี่ยนข้อมูลในเซลล์
6 เฉลยข้อ จ. Formula Bar (แถบสูตรคํานวณ)

คําอธิบาย

1. Name Box (กล่องชื่อเซลล์) เป็นส่วนแสดงชื่อเซลล์ท่ีทํางานอยู่ขณะนั้น
2. Cell (เซลล์) เป็นส่วนท่ีใช้ในการอ้างอิง โดยเป็นส่วนของ Column และ Row ตัดกัน
3. Row (แถว) เป็นส่วนแสดงพ้ืนท่ีในแผ่นงานตามแนวนอนโดยมีจํานวนแถวท้ังหมด

1,048,576 แถว
4. Column (คอลัมน์/สดมภ์) เป็นส่วนแสดงพ้ืนที่ในแผ่นงานตามแนวต้ัง โดยมีจํานวน

คอลัมน์ท้ังหมด 16,384 คอลัมน์ ตั้งแต่คอลัมน์ A ถึงคอลัมน์ XFD
5. Formula Bar (แถบสูตรคํานวณ) เป็นส่วนแสดงสูตรในการคํานวณรวมทั้งแก้ไขหรือ

ปรับเปลี่ยนข้อมูลในเซลล์



7 เฉลยข้อ จ. Cell F4
คําอธิบาย

Cell (เซลล์) เป็นส่วนที่ใช้ในการอ้างอิง โดยเป็นส่วนของ Column และ Row ตัดกัน ดังภาพ
ข้างต้น Active Cell อยู่ท่ี Column F, Row 4 หมายความว่าขณะนี้ทํางานอยู่ท่ี Cell F4

8 เฉลยข้อ ก. File (ไฟล์)
คําอธิบาย File (ไฟล์) ใช้ในการเข้าสู่ Backstage View เพื่อจัดการกับไฟล์งานต่าง ๆ เช่น การ
บันทึกไฟล์ การเปิด-ปิดไฟล์ และการพิมพ์งาน เป็นต้น

9 เฉลยข้อ จ. ใช้ในการกําหนดลักษณะท่ัวไปของแผ่นงาน เช่น แบบอักษร สีของแผ่นงาน เป็นต้น
คําอธิบาย Home ประกอบด้วยกลุ่มคําส่ัง 7 กลุ่ม ได้แก่

กลุ่มท่ี 1 Clipboard (คลิปบอร์ด) ใช้ในการจัดการข้อมูลในแผ่นงาน เช่น การคัดลอก การ
ตัดข้อมูล เป็นต้น

กลุ่มที่ 2 Font (แบบอักษร) ใช้ในการกําหนดลักษณะของตัวอักษร เช่น ขนาด สีตัวอักษร
เป็นต้น

กลุ่มที่ 3 Alignment (การจัดแนว) ใช้สําหรับกําหนดการเรียงของตัวอักษร เช่น ให้ตัวอักษร
ชิดขอบซ้าย หรืออยู่กึ่งกลางหน้ากระดาษ เป็นต้น

กลุ่มที่ 4 Number (ตัวเลข) ใช้ในการกําหนดรูปแบบของตัวเลข เช่น กําหนดให้เป็นเลข
จํานวนเต็ม แสดงตัวเลขในรูปทศนิยม เป็นต้น

กลุ่มท่ี 5 Styles (ลักษณะ) ใช้ในการจัดรูปแบบของข้อมูล
กลุ่มท่ี 6 Cells (เซลล์)
กลุ่มท่ี 7 Editing (การแก้ไข)

10 เฉลยข้อ ข. Home (หน้าแรก)
คําอธิบาย Home ประกอบด้วยกลุ่มคําส่ัง 7 กลุ่ม

กลุ่มที่ 2 Font (แบบอักษร) ใช้ในการกําหนดลักษณะของตัวอักษร เช่น ขนาด สีตัวอักษร



เป็นต้น



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 2
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 3-4

ช่ือหน่วยการเรียนรู้ การปอ้นและจัดเก็บข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การปอ้นและจัดเก็บข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.ประเภทและชนิดของข้อมูล
2.การใช้แป้นควบคุมการทํางานและการใช้ฟงักช์ันคีย์ (Function key)
3.วิธีป้อนข้อมูลลงในเซลล์

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงความรู้เกี่ยวกับการป้อนและจัดเก็บข้อมูล บนโปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.อธิบายประเภทและชนิดของข้อมูลได้
2.ใช้แป้นควบคุมการทํางานและการใช้ฟงัก์ชันคีย์ (Function key) ได้
3.ป้อนข้อมูลลงในเซลล์ได้

5. สาระการเรียนรู้
1.ประเภทและชนิดของข้อมูล
2.การใช้แป้นควบคุมการทํางานและการใช้ฟงักช์ันคีย์ (Function key)
3.วิธีป้อนข้อมูลลงในเซลล์

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0



50-54 1
55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้



9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 2 หน่วยที่ 2
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 3-4

ช่ือหน่วยการเรียนรู้ การป้อนและจัดเก็บข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การป้อนและจัดเก็บข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
Microsoft Excel 2016 สามารถใชง้านกับข้อมูลได้หลายประเภท ผูใ้ชส้ามารถกําหนดการป้อนข้อมูล

ประเภทตา่ง ๆ ใหส้อดคลอ้งกับลักษณะของข้อมูลและงานท่ีจะจัดทํา ข้อมูลท่ีป้อนลงในเซลลนั้นสามารถทําการ
แกไ้ข คัดลอกหรือย้ายไปยังเซลล์อื่น ๆ ได้ และในการทํางานผูใ้ช้สามารถป้อนข้อมูลลงในแผ่นงานได้หลายแผ่น
งานและเรียกใช้ได้ถึง 256 แผ่นงานในสมุดงานหนึ่ง ๆ
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงความรู้เก่ียวกับการป้อนและจัดเก็บข้อมูล บนโปรแกรม Microsoft Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.อธิบายประเภทและชนิดของข้อมูลได้
2.ใช้แป้นควบคุมการทํางานและการใช้ฟังก์ชันคีย์ (Function key) ได้
3.ป้อนข้อมูลลงในเซลล์ได้

5. เน้ือหาสาระ
การป้อนและจัดเก็บข้อมูล



















6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 2 หน่วยที่ 2
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 3-4

ช่ือหน่วยการเรียนรู้ การป้อนและจัดเก็บข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง การป้อนและจัดเก็บข้อมูล

แบบฝึกหัด
1. กลุ่มคําสั่งการคํานวณ (Calculation) อยู่ท่ีแท็บใด

ก. File (ไฟล์)
ข. Home (หน้าแรก)
ค. Insert (แทรก)
ง. Page Layout (เค้าโครงหน้ากระดาษ)
จ. Formula (สูตร)

2. ข้อใดเป็นคําสั่งในการเพิ่มตําแหน่งทศนิยม
ก.
ข.
ค.
ง.
จ.

3. เป็นสัญลักษณ์ในการแทรกแผนภูมิชนิดใด
ก. แผนภูมิแท่งในแนวตั้ง
ข. แผนภูมิวงกลม
ค. แผนภูมิรูปแบบสถิติ
ง. แผนภูมิลําดับขั้น
จ. แผนภูมิเส้นกราฟ

14. ข้อใดเป็นสัญลักษณ์การคํานวณผลรวม
ก.

ข.

ค.

ง.

จ.

5. ข้อใดเป็นคีย์ลัดสําหรับการเปิดสมุดงานท่ีมีอยู่แล้วขึ้นมาแก้ไขหรือทําต่อ



ก. การกด Ctrl + N
ข. การกด Ctrl + S
ค. การกด Ctrl + O
ง. การกด Ctrl + C
จ. การกด Alt + F4

6. ข้อใดไม่ใช่ข้อมูลประเภทค่าคงท่ี
ก. ตัวเลข
ข. ตัวอักษร
ค. เวลา
ง. วันท่ี
จ. สูตรคํานวณ

7. ข้อใดไม่ใช่ข้อมูลประเภทข้อความ (Text)
ก. ตัวอักษร A-Z
ข. ตัวอักษร ก-ฮ
ค. ตัวเลขท่ีไม่ได้ใช้ในการคํานวณ
ง. ข้อมูลท่ีสามารถนํามาคํานวณได้
จ. เครื่องหมายหรือสัญลักษณ์ต่าง ๆ

8. ข้อใดเป็นการใส่สูตรท่ีถูกต้อง
ก. =SUM(A1+A4)
ข. SUM=(A1+A4)
ค. SUM@(A1+A4)
ง. SUM : (A1+A4)
จ. : SUM(A1+A4)

9. ข้อใดเป็นแป้นพิมพ์ที่ใช้ควบคุมการทํางานในการเลื่อนเคอร์เซอร์ไปทางซ้ายท่ีละ 1 ตัวอักษร
ก.

ข.

ค.

ง.

จ.

10. จากภาพ เป็นแป้นพิมพ์ท่ีใช้ควบคุมการทํางานใด

ก. ไปยังเซลล์แรกคือ A1
ข. ไปยังคอลัมน์ A ท่ี Cell Pointer ทํางานอยู่
ค. ไปยังเซลล์ล่างสุดมุมขวาของช่วงข้อมูลในแผ่นงาน



ง. เลื่อนเคอร์เซอร์ไปยังเซลล์ทางซ้ายสุดของข้อมูลในแถวท่ี Cell Pointer ทํางานอยู่
จ. เลื่อนเคอร์เซอร์ไปยังเซลล์ทางขวาสุดของข้อมูลในแถวท่ี Cell Pointer ทํางานอยู่



เฉลยข้อสอบ

ข้อท่ี เฉลย

1 เฉลยข้อ จ. Formula (สูตร)
คําอธิบาย แท็บ Formulas (สูตร) ประกอบด้วยกลุ่มคําส่ัง 4 กลุ่ม

กลุ่มท่ี 4 Calculation (การคํานวณ) ใช้ในการควบคุมการคํานวณข้อมูลในแผ่นงาน

2 เฉลยข้อ ง.
คําอธิบาย

หมายเลข คําส่ังภาษาอังกฤษ Short Key หน้าท่ีการทํางาน

1
Accounting
Number Format

-
รูปแบบตัวเลขทางบัญชี

2 Percent Style (Ctrl+Shift+%) แสดงตัวเลขเป็นเปอร์เซ็นต์

3 Comma Style -
ใช้จุลภาคค่ันท่ีหลักพัน ทุก 3 หลัก
ถัดไป

4 Increase Decimal - เพิ่มตําแหน่งทศนิยม
5 Decrease Decimal - ลดตําแหน่งทศนิยม

3 เฉลยข้อ ค. แผนภูมิรูปแบบสถิติ
คําอธิบาย

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
1 Column or Bar แทรกแผนภูมิแท่งในแนวตั้ง
2 Line แทรกเส้นกราฟ
3 Pie แทรกแผนภูมิวงกลม
4 Hierarchy แทรกแผนภูมิลําดับขั้น
5 Statistic แทรกแผนภูมิรูปแบบสถิติ



6 Scatter แทรกกราฟแสดงการกระจายข้อมูล
7 Other Charts แทรกแผนภูมิรูปแบบอื่น
8 Combo แทรกแผนภูมิแบบคอมโบ

4 เฉลยข้อ ข.
คําอธิบาย

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
1 Insert Function แทรกฟังก์ชัน
2 AutoSum คํานวณผลรวม
3 Recently Used ฟังก์ชันที่ใช้ล่าสุด (เรียกดูและเลือกจากรายการของ

ฟังก์ชันท่ีใช้ล่าสุด)
4 Financial การเงิน (เรียกดูและเลือกจากรายการฟังก์ชันการเงิน)
5 Logical แบบตรรกะ (เรียกดูและเลือกจากรายการฟังก์ชัน

ตรรกศาสตร์)
6 Text Function ฟังก์ชันข้อความ (เรียกดูและเลือกจากรายการฟังก์ชัน

ข้อความ)
7 Date & Time วันท่ีและเวลา
8 Lookup & Reference การค้นหาและการอ้างอิง
9 Math & Trig คณิตศาสตร์และตรีโกณมิติ (เรียกดูและเลือกจาก

รายการฟังก์ชันคณิตศาสตร์และตรีโกณมิต)ิ
10 More Functions ฟังก์ชันเพิ่มเติม

5 เฉลยข้อ ค. การกด Ctrl + O
คําอธิบาย การกด Ctrl + O เป็นการเปิดสมุดงาน คือ การเรียกสมุดงานข้ึนมาทําต่อหรือแก้ไข

การกด Ctrl + N เป็นการสร้างสมุดงานใหม่
การกด Ctrl + S เป็นการบันทึกหรือจัดเก็บสมุดงาน
การกด Ctrl + C เป็นการคัดลอกข้อความ
การกด Alt + F4 เป็นการออกจากโปรแกรม

6 เฉลยข้อ จ. สูตรคํานวณ
คําอธิบาย ประเภทของข้อมูล ข้อมูลท่ีใช้ในแผ่นงาน (Worksheet) แบ่งออกเป็น 2 ประเภทใหญ่ ๆ
คือ

1. ค่าคงที่ (Constant) เป็นข้อมูลที่ไม่เปล่ียนแปลงประกอบด้วยข้อมูลที่เป็นตัวเลข ตัวอักษร
เวลา วันท่ี ข้อมูลทางตรรกศาสตร์ หรือข้อความท่ีแสดงความผิดพลาดต่าง ๆ ท่ีเกิดข้ึน

2. สูตรในการคํานวณ (Formula) เป็นข้อมูลที่เกี่ยวข้องกับการคํานวณต่าง ๆ เพื่อหาผลลัพธ์
จากการคํานวณ ไม่ว่าจะเป็นสูตรหรือฟังก์ชันทางคณิตศาสตร์ สูตรการคํานวณที่ผู้ใช้เขียนขึ้นหรือ
กําหนดข้ึนมาเอง



7 เฉลยข้อ ง. ข้อมูลท่ีสามารถนํามาคํานวณได้
คําอธิบาย ข้อความ (Text) ได้แก่ ตัวอักษร A-Z, ก-ฮ, เครื่องหมายหรือสัญลักษณ์ต่าง ๆ และตัวเลข
ที่ไม่ได้ใช้ในการคํานวณ ใน 1 เซลล์ สามารถพิมพ์อักขระลงไปได้สูงสุดถึง 256 ตัว การแสดงผลใน
เซลล์ ข้อความจะอยู่ชิดขอบซ้ายของเซลล์และตัวเลขจะอยู่ชิดขอบขวาของเซลล์ (ดังภาพ)

8 เฉลยข้อ ก. =SUM(A1+A4)
คําอธิบาย สูตร (Formula) คือ สูตรการคํานวณทางคณิตศาสตร์ที่ประกอบด้วยเคร่ืองหมายทาง
คณิตศาสตร์ เครื่องหมายเปรียบเทียบ เชื่อมข้อความ อ้างอิง หรือฟังก์ชันต่าง ๆ มีลักษณะดังนี้

• ข้อมูลจะต้องขึ้นต้นด้วยเคร่ืองหมายบวก (+), เคร่ืองหมายลบ (-), เคร่ืองหมายเท่ากับ (=)
ซึ่งใช้ในการคํานวณ แล้วตามด้วยชื่อเซลล์ ตัวเลข ตําแหน่งเซลล์ หรือเคร่ืองหมายอื่นๆ เช่น
+A1+A2+A3 หรือ =A1+A2+A3 เป็นต้น

• สามารถนําหน้าด้วยเครื่องหมาย @ หรือเครื่องหมายเท่ากับ (=) ได้ เช่น @SUM(A1,A3)
หรือ =SUM(A1:A3) เป็นต้น

9 เฉลยข้อ ก.
คําอธิบาย

แป้น คําอธิบาย
ลูกศรเล่ือนเคอร์เซอร์ไปทางซ้ายที่ละ 1 ตัวอักษร

ลูกศรเล่ือนเคอร์เซอร์ไปทางขวาทีละ 1 ตัวอักษร

ลูกศรเล่ือนเคอร์เซอร์ข้ึนทีละ 1 บรรทัด

ลูกศรเล่ือนเคอร์เซอร์ลงทีละ 1 บรรทัด

เลื่อนเคอร์เซอร์ไปยังเซลล์ทางซ้ายสุดของข้อมูลในแถวท่ี Cell Pointer
ทํางานอยู่
เลื่อนเคอร์เซอร์ไปยังเซลล์ทางขวาสุดของข้อมูลในแถวท่ี Cell Pointer
ทํางานอยู่
เลื่อนเคอร์เซอร์ไปยังเซลล์บนสุดของข้อมูลในคอลัมน์ท่ี Cell Pointer
ทํางานอยู่
เล่ือนเคอร์เซอร์ไปยังเซลล์ล่างสุดของข้อมูลในคอลัมน์ที่ Cell Pointer
ทํางานอยู่

10 เฉลยข้อ ข. ไปยังคอลัมน์ A ท่ี Cell Pointer ทํางานอยู่
คําอธิบาย

แป้น คําอธิบาย



ไปยังคอลัมน์ A ท่ี Cell Pointer ทํางานอยู่

ไปยังเซลล์แรกคือ A1

กดปุ่ม End ค้างไว้แล้วกดลูกศรโดยผลท่ีได้เหมือนกับการกด Ctrl
ค้างไว้ แล้วกดลูกศร
ไปยังเซลล์ล่างสุดมุมขวาของช่วงข้อมูลในแผ่นงาน



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 3
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 5-6

ช่ือหน่วยการเรียนรู้ การแก้ไขและตกแต่งขอ้มูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การแก้ไขและตกแต่งขอ้มูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.ประเภทและชนิดของข้อมูล
2.การใช้แป้นควบคุมการทํางานและการใช้ฟงักช์ันคีย์ (Function key)
3.วิธีป้อนข้อมูลลงในเซลล์

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงความรู้เกี่ยวกับการป้อนและจัดเก็บข้อมูล บนโปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.อธิบายประเภทและชนิดของข้อมูลได้
2.ใช้แป้นควบคุมการทํางานและการใช้ฟงัก์ชันคีย์ (Function key) ได้
3.ป้อนข้อมูลลงในเซลล์ได้

5. สาระการเรียนรู้
1.ประเภทและชนิดของข้อมูล
2.การใช้แป้นควบคุมการทํางานและการใช้ฟงักช์ันคีย์ (Function key)
3.วิธีป้อนข้อมูลลงในเซลล์

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0



50-54 1
55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้



9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 3 หน่วยที่ 3
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 5-6

ช่ือหน่วยการเรียนรู้ การแก้ไขและตกแต่งข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การแก้ไขและตกแต่งข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
Microsoft Excel 2016 สามารถใชง้านกับข้อมูลได้หลายประเภท ผูใ้ชส้ามารถกําหนดการป้อนข้อมูล

ประเภทตา่ง ๆ ใหส้อดคลอ้งกับลักษณะของข้อมูลและงานท่ีจะจัดทํา ข้อมูลท่ีป้อนลงในเซลลนั้นสามารถทําการ
แกไ้ข คัดลอกหรือย้ายไปยังเซลล์อื่น ๆ ได้ และในการทํางานผูใ้ช้สามารถป้อนข้อมูลลงในแผ่นงานได้หลายแผ่น
งานและเรียกใช้ได้ถึง 256 แผ่นงานในสมุดงานหนึ่ง ๆ
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงความรู้เก่ียวกับการป้อนและจัดเก็บข้อมูล บนโปรแกรม Microsoft Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.อธิบายประเภทและชนิดของข้อมูลได้
2.ใช้แป้นควบคุมการทํางานและการใช้ฟังก์ชันคีย์ (Function key) ได้
3.ป้อนข้อมูลลงในเซลล์ได้

5. เน้ือหาสาระ





























6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 3 หน่วยที่ 3
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 5-6

ช่ือหน่วยการเรียนรู้ การแก้ไขและตกแต่งข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือ การแก้ไขและตกแต่งข้อมูล

แบบฝึกหัด
1. ข้อใดเป็นแป้นพิมพ์ที่ใช้ควบคุมการทํางานในการลบตัวอักษรทางด้านขวาของเคอร์เซอร์

ก.

ข.

ค.

ง.

จ.

2. การกดปุ่ม Enter ตําแหน่ง Cell Pointer จะเล่ือนไปทิศทางใดเสมอ
ก. เลื่อนลงไปแถวถัดไป
ข. เลื่อนขึ้นไปแถวถัดไป
ค. เลื่อนไปท่ี Cell ทางด้านซ้าย
ง. เลื่อนไปท่ี Cell ทางด้านขวา
จ. เลื่อนไปท่ี Cell A1

3. ข้อใดเป็นเครื่องหมายทางคณิตศาสตร์การหารท่ีใช้ใน Microsoft Excel
ก. +
ข. -
ค. /
ง. *
จ. %

4. ข้อใดเป็นลักษณะการช้ีเมาส์ท่ีอยู่ในสถานะในการป้อนข้อมูลในเซลล์
ก.

ข.

ค.

ง.



จ.

5. ข้อมูลในข้อใดจะถูกจัดชิดทางขวาของเซลล์
ก. ขวด
ข. Bird
ค. :P
ง. 48
จ. 99A

6. หากต้องการแก้ไขข้อมูลภายในเซลล์ มีวิธีการอย่างไรเพ่ือเลือกเซลล์ท่ีต้องการแก้ไข
ก. ดับเบิ้ลคลิกท่ีเซลล์ท่ีต้องการจะแก้ไข
ข. เลือกเซลล์ท่ีต้องการแก้ไข และดับเบิลคลิก
ค. คลิกเลือกเซลล์ที่จะแก้ไขแล้วกดปุ่มฟังก์ชันคีย์ F2
ง. คลิกเลือกเซลล์ที่จะแก้ไขและทําการแก้ไขที่ Formula bar (แถบสูตร)
จ. ถูกทุกข้อ

7. การกดแป้นพิมพ์ Ctrl+Z เป็นการส่ังการทํางานในข้อใด
ก. การยกเลิก (Undo)
ข. การทําซํ้า (Redo)
ค. การคัดลอก (Copy)
ง. การวาง (Paste)
จ. การเคลื่อนย้ายข้อมูล (Cut)

8. การใช้เมาส์คลิกลงในเซลล์ท่ีต้องการ เป็นการส่ังการทํางานในข้อใด
ก. เป็นการแก้ไขข้อมูลภายเซลล์
ข. เป็นการเลือกเซลล์
ค. เป็นการเคลื่อนย้ายข้อมูลภายในเซลล์
ง. เป็นการคัดลอกข้อมูลภายในเซลล์
จ. เป็นการลบข้อมูลภายในเซลล์

9. จากภาพ เป็นการเลือกในส่วนใด

ก. การเลือกเซลล์ที่อยู่ติดกัน
ข. การเลือกเซลล์ที่ไม่อยู่ติดกัน
ค. การเลือกเฉพาะแถว
ง. การเลือกเฉพาะคอลัมน์
จ. การเลือกทั้งแผ่นงาน



10. จากภาพ ตรงกับการกดแป้นพิมพ์ใด
ก. กดแป้นพิมพ์ Ctrl+U
ข. กดแป้นพิมพ์ Ctrl+B
ค. กดแป้นพิมพ์ Ctrl+C
ง. กดแป้นพิมพ์ Ctrl+I
จ. กดแป้นพิมพ์ Ctrl+V



เฉลยข้อสอบ

ข้อท่ี เฉลย

1 เฉลยข้อ ค.
คําอธิบาย

แป้น คําอธิบาย
ไปยังเซลล์ที่อยู่ถัดลงไปด้านล่างของ Cell Pointer ที่ Active Cell
นั้นอยู่
ไปยังเซลล์ทางขวาที่ไม่ได้ถูกล็อกไว้ (ในแผ่นงานที่มีการป้องกัน
ข้อมูล)
ไปยังเซลล์ทางซ้ายที่ไม่ได้ถูกล็อกไว้ (ในแผ่นงานที่มีการป้องกัน
ข้อมูล)
ลบตัวอักษรทางด้านขวาของเคอร์เซอร์

ลบตัวอักษรทางด้านขวาของเคอร์เซอร์ทั้งหมด

ลบตัวอักษรทางด้านซ้ายของเคอร์เซอร์

2 เฉลยข้อ ก. เลื่อนลงไปแถวถัดไป
คําอธิบาย การป้อนข้อมูลโดยค่าปกติของโปรแกรม Microsoft Excel หลังจากการกดปุ่ม Enter
ตําแหน่ง Cell Pointer จะเล่ือนลงไปแถวถัดไปเสมอ ไม่สามารถควบคุมให้ว่ิงไปทางขวาได้

3 เฉลยข้อ ค. /
คําอธิบาย เครื่องหมายทางคณิตศาสตร์

+ หมายถึง บวก
- หมายถึง ลบ
* หมายถึง คูณ
/ หมายถึง หาร
^ หมายถึง ยกกําลัง
% หมายถึง หารด้วย 100

4 เฉลยข้อ ค.
คําอธิบาย

แป้น คําอธิบาย
สถานะพร้อมที่จะเลือก (Selection)

สถานะบนเซลล์พร้อมจะทําการคัดลอกสูตร

สถานะในการป้อนข้อมูลในเซลล์



สถานะพร้อมที่จะย่อ/ขยายคอลัมน์ในตําแหน่งตัวชี้อยู่ที่รอยต่อ
ระหว่างคอลัมน์
สถานะพร้อมที่จะย่อ/ขยายแถวในตําแหน่งตัวชี้อยู่ที่รอยต่อระหว่าง
แถว
สถานะพร้อมที่จะย้ายข้อมูลในเซลล์นั้นไปยังตําแหน่งท่ีต้องการ

5 เฉลยข้อ ง. 48
คําอธิบาย 1. ข้อมูลประเภทตัวหนังสือ (Text) จะถูกจัดชิดซ้ายของเซลล์

2. ข้อมูลประเภทตัวเลข (Number), วันท่ี เวลา (Date & Time), ผลลัพธ์จากสูตรและ
ฟังก์ชันการคํานวณ (Formula & Function) จะถูกจัดชิดขวาของเซลล์

6 เฉลยข้อ จ. ถูกทุกข้อ
คําอธิบาย การแก้ไขข้อมูลภายในเซลล์ (Edit)

เมื่อมีการป้อนข้อมูลแล้วพบว่าเกิดข้อผิดพลาดขึ้น สามารถปรับเปล่ียนหรือแก้ไขข้อมูลน้ันได้
โดยทําได้หลายรูปแบบด้วยกัน คือ

1. ดับเบิลคลิกเซลล์ท่ีจะแก้ไขและพิมพ์ข้อมูลใหม่ทับข้อมูลเดิม
2. คลิกเลือกเซลล์ที่จะแก้ไขแล้วกดปุ่มฟังก์ชันคีย์ F2 จะปรากฏเคอร์เซอร์อยู่ท้ายข้อมูลใน

เซลล์ ใช้ลูกศรเล่ือนหรือใช้เมาส์ท่ีเป็นรูป I-beam (ไอบีม) คลิกตรงตําแหน่งท่ีจะแก้ไข
ถ้าเซลล์นั้นเป็นสูตรคํานวณเม่ือกดปุ่ม F2 จะแสดงเป็นสูตรคํานวณให้แก้ไข
3. เลือกเซลล์ที่ต้องการแก้ไข และดับเบิลคลิกจากนั้นให้แก้ไขหรือปรับเปลี่ยนข้อมูลในเซลล์

นั้น ได้ทันที
4. คลิกเลือกเซลล์ที่จะแก้ไขและทําการแก้ไขที่ Formula bar (แถบสูตร)

7 เฉลยข้อ ก. การยกเลิก (Undo)
คําอธิบาย การยกเลิก (Undo) เป็นคําสั่งการยกเลิกงานที่ละงานเพื่อให้ข้อมูล หรือข้อความนั้น
กลับคืนมาใหม่ ในโปรแกรม Microsoft Excel 2016 มีความสามารถในการจดจําคําสั่งย้อนหลังซ่ึง
การยกเลิก (Undo) สามารถปฏิบัติได้ดังนี้

1. คลิกท่ีคําส่ัง ท่ีอยู่บนแถบเครื่องมือด่วน (Quick Access Toolbars) หรือ
2. กดแป้นพิมพ์ Ctrl+Z
หากต้องการทําการยกเลิกหลาย ๆ คร้ังพร้อมกันทีเดียว ให้คลิกเมาส์ท่ีลูกศรของคําสั่ง Undo

จะปรากฏรายการคําส่ังที่ได้ทําไปแล้ว รายการด้านบนคืองานที่เพิ่งทําเสร็จไปหลังสุด
และรายการด้านล่างคืองานเก่าที่สุดที่จะยกเลิกได้ จากนั้นให้ใช้เมาส์เลือกคลุมให้เกิดแถบสีตาม
รายการท่ีต้องการยกเลิก แล้วคลิกเมาส์

8 เฉลยข้อ ข. เป็นการเลือกเซลล์
คําอธิบาย การเลือกเซลล์ (Cell Selection)

การเลือกเซลล์เป็นการเลือกพื้นที่เพื่อใช้ใส่ข้อมูลและรูปแบบต่าง ๆ รวมถึงการกําหนด
รูปแบบของตัวอักษร การกําหนดสีให้กับเซลล์และตัวอักษรการเคลื่อนย้ายกลุ่มของข้อมูล

การเลือกเซลล์ในโปรแกรม Microsoft Excel 2016 สามารถจัดการได้หลายรูปแบบ
ดังต่อไปนี้



การเลือกเซลล์เดียว
1. ใช้เมาส์คลิกลงในเซลล์ท่ีต้องการ
2. ใช้แป้นลูกศรในการเลื่อน ข้ึน-ลง หรือไปทาง ซ้าย-ขวา โดยจะเลื่อนไปทีละ 1 เซลล์

9 เฉลยข้อ ง. การเลือกเฉพาะคอลัมน์
คําอธิบาย การเลือกเฉพาะคอลัมน์และเลือกหลายๆ คอลัมน์

1. คลิกตรงตัวอักษรกํากับคอลัมน์ (ตัวอักษร A-XFD)

2. ถ้าเลือกหลาย ๆ คอลัมน์ให้คลิกที่ตัวอักษรกํากับและกดเมาส์ค้างไว้ลากไปยังคอลัมน์ท่ี
ต้องการกําหนดจากนั้นจึงปล่อยเมาส์

10 เฉลยข้อ จ. กดแป้นพิมพ์ Ctrl+V
คําอธิบาย คลิกท่ีแท็บ Home (หน้าแรก) เลือกคําสั่ง Paste (วาง) หรือกดแป้นพิมพ์ Ctrl+V หรือ
คลิกขวาแล้วเลือกคําสั่ง Paste (วาง)

ตัวอย่างของการ Paste โดยใช้รูปแบบ Paste



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 4
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 7-8

ช่ือหน่วยการเรียนรู้ การสร้างตารางข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การสร้างตารางข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.การจัดการกับแผ่นงาน
2.วิธีการจัดรูปแบบข้อมูล
3.การกําหนดรูปแบบตัวอักษร (Font)
4.การกําหนดรูปแบบตัวเลข (Number)
5.การกําหนดรูปแบบวันที่และเวลา (Date and Time)
6.การจัดวางข้อความ (Alignment)
7.การกําหนดเส้นขอบ (Border)
8.การกําหนดสีและลวดลาย (Pattern)

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงการสร้างตารางข้อมูลด้วยโปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.จัดการกับแผ่นงานําได้
2.จัดรูปแบบข้อมูลได้
3.กําหนดรูปแบบตัวอักษร (Font) ได้
4.กําหนดรูปแบบตัวเลข (Number) ได้
5.กําหนดรูปแบบวันท่ีและเวลา (Date and Time) ได้
6.จัดวางข้อความ (Alignment) ได้
7.กําหนดเส้นขอบ (Border) ได้
8.กําหนดสีและลวดลาย (Pattern) ได้

5. สาระการเรียนรู้
1.การจัดการกับแผ่นงาน
2.วิธีการจัดรูปแบบข้อมูล
3.การกําหนดรูปแบบตัวอักษร (Font)
4.การกําหนดรูปแบบตัวเลข (Number)



5.การกําหนดรูปแบบวันที่และเวลา (Date and Time)
6.การจัดวางข้อความ (Alignment)
7.การกําหนดเส้นขอบ (Border)
8.การกําหนดสีและลวดลาย (Pattern)

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0
50-54 1
55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน



เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 4 หน่วยที่ 4
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 7-8

ช่ือหน่วยการเรียนรู้ การสร้างตารางข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การสร้างตารางข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
โปรแกรม Microsoft Excel 2016 สามารถจัดการข้อมูลได้หลากหลายรูปแบบ เพื่อความเป็นระเบียบของ

ข้อมูลจึงมีการจัดข้อมูลให้อยู่ในรูปแบบตาราง ในหน่วยนี้ จะเป็นการศึกษาเก่ียวกับการจัดการแผ่นงาน และการ
กําหนดรูปแบบของข้อมูลตารางให้มีความเหมาะสม
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงการสร้างตารางข้อมูลด้วยโปรแกรม Microsoft Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.จัดการกับแผ่นงานําได้
2.จัดรูปแบบข้อมูลได้
3.กําหนดรูปแบบตัวอักษร (Font) ได้
4.กําหนดรูปแบบตัวเลข (Number) ได้
5.กําหนดรูปแบบวันท่ีและเวลา (Date and Time) ได้
6.จัดวางข้อความ (Alignment) ได้
7.กําหนดเส้นขอบ (Border) ได้
8.กําหนดสีและลวดลาย (Pattern) ได้



5. เน้ือหาสาระ



























6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 4 หน่วยที่ 4
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 7-8

ช่ือหน่วยการเรียนรู้ การสร้างตารางข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือ การสร้างตารางข้อมูล

แบบฝึกหัด
1. การกดแป้นพิมพ์ Ctrl+X ตรงกับการสั่งการทํางานในข้อใด

ก.

ข.

ค.

ง.

จ.

2. จากภาพ เป็นการส่ังการแทรกสิ่งใด
ก. แทรกเซลล์ (Insert Cells)
ข. แทรกแถวในแผ่นงาน (Insert Sheet Rows)
ค. แทรกคอลัมน์ในแผ่นงาน (Insert Sheet Columns)
ง. แทรกเวิร์คชีต (Insert Worksheets)
จ. แทรกเวิร์คบุ๊ค (Insert Workbooks)

3. ข้อใดเป็นสัญลักษณ์ของการสั่งงานการลบแถว (Delete Row)
ก.

ข.

ค.

ง.

จ.

4. หากต้องการปรับความสูงของแถว ต้องไปท่ีแท็บ Home (หน้าแรก) แล้วเลือกท่ีคําส่ังใด
ก.



ข.

ค.

ง.

จ.

5.

จากภาพ เป็นผลลัพธ์ท่ีได้จากการใช้คําสั่งใด
ก. การซ่อนแถว (Hide Rows)
ข. การซ่อนคอลัมน์ (Hide Columns)
ค. การลบแถว (Delete Row)
ง. การลบคอลัมน์ (Delete Column)
จ. การแทรกแถว (Insert Row)

6. การเพ่ิมแผ่นงานในโปรแกรม Microsoft Excel 2016 สามารถเพ่ิมได้ก่ีแผ่นงาน
ก. 245 แผ่นงาน
ข. 254 แผ่นงาน
ค. 256 แผ่นงาน
ง. 265 แผ่นงาน
จ. 246 แผ่นงาน

7. ข้อใดเป็นคําสั่งในการแทรกแผ่นงาน (Insert Sheet)
ก.

ข.

ค.

ง.

จ.



จากภาพการจัดรูปแบบด้วยการใช้คําสั่งท่ีแท็บ Home ใช้ตอบคําถามข้อ 38-40

8. หากต้องการกําหนดรูปแบบตัวเลขดังภาพ ควรเลือกตัวเลือกใดใน Category ของหมวด
Number (ตัวเลข)

ก. General
ข. Number
ค. Currency
ง. Percentage
จ. Special

9. หากต้องการจัดตําแหน่งข้อความให้อยู่กึ่งกลางของเซลล์ ควรเลือกตัวเลือกจากกลุ่มคําสั่งใด
ก. Number
ข. Alignment
ค. Font
ง. Border
จ. Fill

10. หากต้องการเปลี่ยนรูปแบบตัวอักษร ควรเลือกตัวเลือกจากกลุ่มคําสั่งใด
ก. Number
ข. Alignment
ค. Font
ง. Border
จ. Fill



เฉลยข้อสอบ

ข้อท่ี เฉลย

1 เฉลยข้อ ข.
คําอธิบาย การเคล่ือนย้ายข้อมูล (Cut) คือ การย้ายข้อมูลจากที่หนึ่งไปไว้อีกที่หน่ึง ซึ่งจะแตกต่าง
จากการคัดลอก คือ การย้ายข้อมูลน้ันข้อมูลเดิมจะหายไป แต่การคัดลอกข้อมูลเดิมจะยังแสดงให้
เห็นอยู่ ซ่ึงในการเคล่ือนย้ายข้อมูล (Cut) สามารถทําได้ดังนี้

1. เลือกช่วงของเซลล์ข้อมูลท่ีต้องการจะเกิดเป็นแถบสี

2. คลิกท่ีแท็บ Home (หน้าแรก) เลือกคําสั่ง Cut (ย้ายข้อมูล) หรือกดแป้นพิมพ์ Ctrl+X
หรือคลิกขวาแล้วเลือกคําส่ัง Cut (ย้ายข้อมูล)

3. จะเกิดเส้นประว่ิงล้อมรอบข้อมูลท่ีเลือกไว้จากนั้นคลิกเลือกตําแหน่งเซลล์ท่ีต้องการวาง
ข้อมูล

4. คลิกท่ีแท็บ Home (หน้าแรก) เลือกคําสั่ง Paste (วาง) หรือกดแป้นพิมพ์ Ctrl+V
หรือคลิกขวาแล้วเลือกคําส่ัง Paste (วาง)

ในกรณีของการย้ายข้อมูล รูปแบบของข้อมูลที่ทําการย้ายจะเหมือนกับข้อมูลเดิมทุกประการ
ตัวอย่างของการย้ายข้อมูล



2 เฉลยข้อ ข. แทรกแถวในแผ่นงาน
คําอธิบาย การแทรกแถว (Insert Row) สามารถปฏิบัติได้ดังนี้

1. คลิกเลือกแถวท่ีต้องการแทรก

2. คลิกท่ีแท็บ Home (หน้าแรก) เลือกคําส่ัง Insert (แทรก) และเลือก Insert Sheet Rows
(แทรกแถวในแผ่นงาน)

หรือคลิกขวาแถวท่ีเลือกไว้คลิกเลือกคําสั่ง Insert (แทรก)

3. ผลลัพธ์ท่ีได้จะปรากฏแถวว่างข้ึนมาตามจํานวนท่ีเลือก

3 เฉลยข้อ ค.
คําอธิบาย การลบแถว (Delete Row) สามารถปฏิบัติได้ดังนี้

1. คลิกเลือกแถวท่ีต้องการลบ

2. คลิกท่ี Delete (ลบ) และเลือก Delete Sheet Rows (ลบแถวในแผ่นงาน)



หรือคลิกขวาในแถวท่ีต้องการลบจะปรากฏเมนูลัดให้เลือก Delete (ลบ)

3. แถวที่เลือกจะถูกลบหายไป (ดังภาพ) ในกรณีนี้ลบแถวที่ 6 วันพฤหัสบดีจะหายไป และ
แถวที่ 7 วันศุกร์ จะขยับข้ึนมาแทนที่

4 เฉลยข้อ จ.
คําอธิบาย การใช้คําสั่งในการปรับความสูงของแถว มีวิธีปฏิบัติดังนี้

1. คลิกเลือกแถวท่ีต้องการปรับความสูง (แถวที่ 1)

2. คลิกที่แท็บ Home (หน้าแรก) เลือกคําสั่ง Format (รูปแบบ) ซึ่งอยู่ในกลุ่มของ Cells
(เซลล์) จะมีคําสั่งย่อย Cell Size ให้เลือกคําส่ัง

Row Height เพื่อกําหนดความสูงให้กับแถวท่ีเลือก
AutoFit Row Height เพื่อปรับความสูงของแถวให้พอดีกับข้อความโดยอัตโนมัติ

3. หากเลือกคําส่ัง Row Height จะปรากฏ Dialog Box ให้กําหนดค่าความสูงของแถว ท่ี
ต้องการ



4. คลิกท่ี OK จะเป็นการปรับขนาดความสูงของแถวท่ีเลือก
5 เฉลยข้อ ก. การซ่อนแถว (Hide Rows)

คําอธิบาย การซ่อนแถว
1. คลิกเลือกแถวท่ีต้องการซ่อน เช่น แถวที่ 4

2. คลิกที่แท็บ Home (หน้าแรก) เลือกคําสั่ง Format (รูปแบบ) ซึ่งอยู่ในกลุ่มของ Cells
(เซลล์) จะมีคําสั่งย่อย Visibility (การมองเห็น) ให้เลือก Hide & Unhide (ซ่อนและยกเลิกการ
ซ่อน) และคลิกเลือกคําสั่ง Hide Rows (ซ่อนแถว)

หรือ 3. คลิกขวา จะปรากฏเมนูลัด ให้คลิกเลือก Hide (ซ่อน)

ผลลัพธ์ท่ีได้จากการใช้คําสั่งซ่อนเป็นดังภาพ

6 เฉลยข้อ ค. 256 แผ่นงาน
คําอธิบาย การเพิ่มแผ่นงานในโปรแกรม Microsoft Excel 2016 สามารถเพิ่มได้ถึง 256 แผ่น



งาน โดยปกติโปรแกรมจะจัดเตรียมมาให้ 3 แผ่นงาน วิธีการเพิ่มแผ่นงานมี 4 วิธี
7 เฉลยข้อ จ.

คําอธิบาย วิธีการเพิ่มแผ่นงาน
วิธีที่ 1 การใช้แท็บเมนูคําสั่ง สามารถปฏิบัติได้ดังนี้
1. คลิกที่แท็บ Home เลือกคําสั่ง Insert (แทรก) จะมีคําสั่งย่อยให้เลือกที่คําสั่ง Insert

Sheet (แทรกแผ่นงาน)

2. จะปรากฏ Sheet2 ให้อัตโนมัติโดยจะแทรกอยู่หน้าแผ่นงานที่ผู้ใช้ทํางานอยู่ (ดังภาพ)

8 เฉลยข้อ ค. Currency
คําอธิบาย การจัดรูปแบบข้อมูลโดยการเรียกใช้คําสั่ง Format (รูปแบบ) ในกลุ่มของ Cells (เซลล์)

การจัดรูปแบบด้วยการใช้คําส่ังที่แท็บ Home และคลิกเลือกที่คําสั่ง Format (รูปแบบ) จะมี
คําสั่งย่อยให้เลือก Format Cells (การจัดรูปแบบเซลล์) จะปรากฏ Dialog Box ให้เลือก โดยมีแท็บ
ให้เลือกใช้งานได้ท้ังหมด 6 แท็บ

รายละเอียดของแท็บ Number
Number (ตัวเลข) ใช้ในการจัดการกับรูปแบบของตัวเลข ให้เป็นไปตามที่ ผู้ใช้ต้องการ

ตัวเลือกต่าง ๆ ในหมวด Category มีดังนี้

General ไม่มีการกําหนดรูปแบบของตัวเลขอย่างเฉพาะเจาะจง
Number กําหนดรูปแบบของตัวเลขเป็นแบบท่ัวไป สามารถกําหนดตําแหน่งจุดทศนิยมและ

ใช้เครื่องหมาย , ค่ันหลักพันได้ เช่น 2,500.00
Currency กําหนดรูปแบบตัวเลขทางการเงิน สามารถกําหนดตําแหน่งจุดทศนิยมและ

สัญลักษณ์ของหน่วยเงิน เช่น ฿100, $50 ได้



Accounting กําหนดรูปแบบตัวเลขทางบัญชี มีลักษณะคล้ายกับตัวเลขทางการเงิน เช่น ฿
150.50

Date กําหนดรูปแบบตัวเลขในรูปแบบวันที่ เช่น 24/5/58
Time กําหนดรูปแบบตัวเลขในรูปแบบเวลา เช่น 12:00:00
Percentage กําหนดรูปแบบตัวเลขเป็นเปอร์เซ็นต์ เช่น 50%
Fraction กําหนดรูปแบบตัวเลขเป็นเศษส่วน เช่น 1 3/4
Scientific กําหนดรูปแบบตัวเลขในรูปแบบวิทยาศาสตร์ เช่น 55.6E+01 มีค่าเท่ากับ 5.56

x 10 = 55.6
Text กําหนดรูปแบบตัวเลขให้เป็นตัวอักษร โดยจะถือว่าตัวเลขท้ังหมดคือตัวอักษรและจะ

แสดงผลในรูปแบบเดียวกับท่ีผู้ใช้ทําการป้อนข้อมูล
Special กําหนดรูปแบบตัวเลขแบบพิเศษ เช่น หมายเลขโทรศัพท์
Custom กําหนดรูปแบบตัวเลขเป็นแบบกําหนดเอง

9 เฉลยข้อ ข. Alignment
คําอธิบาย การจัดรูปแบบข้อมูลโดยการเรียกใช้คําสั่ง Format (รูปแบบ) ในกลุ่มของ Cells (เซลล์)

การจัดรูปแบบด้วยการใช้คําส่ังที่แท็บ Home และคลิกเลือกที่คําสั่ง Format (รูปแบบ) จะมี
คําสั่งย่อยให้เลือก Format Cells (การจัดรูปแบบเซลล์) จะปรากฏ Dialog Box ให้เลือก โดยมีแท็บ
ให้เลือกใช้งานได้ท้ังหมด 6 แท็บ

รายละเอียดของแท็บ Alignment
Alignment (การจัดแนว) ใช้ในการจัดการกับข้อความหรือตัวเลข ให้อยู่ในตําแหน่งท่ีผู้ใช้

ต้องการ

10 เฉลยข้อ ค. Font
คําอธิบาย การจัดรูปแบบข้อมูลโดยการเรียกใช้คําสั่ง Format (รูปแบบ) ในกลุ่มของ Cells (เซลล์)

การจัดรูปแบบด้วยการใช้คําส่ังที่แท็บ Home และคลิกเลือกที่คําสั่ง Format (รูปแบบ) จะมี
คําสั่งย่อยให้เลือก Format Cells (การจัดรูปแบบเซลล์) จะปรากฏ Dialog Box ให้เลือก โดยมีแท็บ
ให้เลือกใช้งานได้ท้ังหมด 6 แท็บ

รายละเอียดของแท็บ Font
Font (แบบอักษร) ใช้กําหนดตัวอักษรในรูปแบบต่าง ๆ ตามท่ีผู้ใช้ต้องการ





บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 5
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 9-10

ช่ือหน่วยการเรียนรู้ การใช้สูตรและฟังก์ชันในการคํานวณ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การใช้สูตรและฟังก์ชันในการคํานวณ

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.วิธีการคํานวณ
2.สัญลักษณ์ท่ีใช้ในการคํานวณ
3.ข้อผิดพลาดท่ีอาจเกิดขึน้ในการกําหนดฟังก์ชันและสูตร
4.ประเภทของฟังกช์ันและฟังก์ชันท่ีใช้งาน
5.การอ้างอิงเซลล์

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงการคํานวณโดยใช้สูตรและฟังก์ชนัในโปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.อธิบายวิธีการคํานวณได้
2.อธิบายสัญลักษณ์ท่ีใช้ในการคํานวณได้
3.อธิบายข้อผิดพลาดท่ีอาจเกิดขึ้นในการกําหนดฟังกช์ันและสูตรได้
4.อธิบายประเภทของฟังก์ชันและฟังก์ชันท่ีใช้งานได้
5.อ้างอิงเซลล์ได้

5. สาระการเรียนรู้
1.วิธีการคํานวณ
2.สัญลักษณ์ท่ีใช้ในการคํานวณ
3.ข้อผิดพลาดท่ีอาจเกิดขึน้ในการกําหนดฟังก์ชันและสูตร
4.ประเภทของฟังกช์ันและฟังก์ชันท่ีใช้งาน
5.การอ้างอิงเซลล์

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน



จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0
50-54 1
55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้



9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 5 หน่วยที่ 5
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 9-10

ช่ือหน่วยการเรียนรู้ การใช้สูตรและฟังก์ชันในการคํานวณ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งานการใช้สูตรและฟังก์ชันในการคํานวณ

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
โปรแกรม Microsoft Excel 2016 เปน็โปรแกรม ท่ีเหมาะกับงานคํานวณดังที่ได้กล่าวมาแล้วไมว่่าจะเปน็

งานบัญชี งานการเงิน งานวัดผล และงานคํานวณท่ัวไป การคํานวณทําไดท้ั้งการํานวณอยา่งง่ายจนถึงการคํานวณ
แบบสลับซับซอ้นเพียงผู้ใช้กําหนดสูตรตามต้องการและสามารถคัดลอกสูตรไปใชใ้นงานลักษณะเดียวกันได้อีก โดย
ไม่ต้องเสียเวลากําหนดสูตรใหม่
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงการคํานวณโดยใช้สูตรและฟังก์ชนัในโปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.อธิบายวิธีการคํานวณได้
2.อธิบายสัญลักษณ์ท่ีใช้ในการคํานวณได้
3.อธิบายข้อผิดพลาดท่ีอาจเกิดขึ้นในการกําหนดฟังกช์ันและสูตรได้
4.อธิบายประเภทของฟังก์ชันและฟังก์ชันท่ีใช้งานได้
5.อ้างอิงเซลล์ได้

5. เน้ือหาสาระ





















6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 5 หน่วยที่ 5
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 9-10

ช่ือหน่วยการเรียนรู้ การใช้สูตรและฟังก์ชันในการคํานวณ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือการใช้สูตรและฟังก์ชันในการคํานวณ

แบบฝึกหัด

1. หากต้องการกําหนดรูปแบบดังภาพ ควรเลือกตัวเลือกจากกลุ่มคําสั่งใด
ก. Number
ข. Alignment
ค. Font
ง. Border
จ. Fill

2. หากต้องการทําให้ข้อมูลในตารางเป็นตัวหนา ควรคลิกท่ีคําส่ังใดจากแท็บ Home (หน้าแรก)
ก.

ข.
ค.

ง.

จ.

3. หากต้องการกําหนดรูปแบบดังภาพ ควรคลิกที่คําส่ังใดจากแท็บ Home
(หน้าแรก)

ก.

ข.

ค.

ง.
จ.



4. ข้อใดเป็นผลจากการคลิกท่ีคําสั่ง ท่ีแท็บ Home ในกลุ่มคําสั่ง Font (แบบอักษร) และคลิกท่ีการ
กําหนดเส้นขอบ

ก.

ข.

ค.

ง.

จ.

5. หากต้องการวาดเส้นขอบของตารางเอง ควรคลิกท่ีคําส่ังใดจากแท็บ Home (หน้าแรก) ในกลุ่มคําส่ัง Font
(แบบอักษร) และคลิกที่การกําหนดเส้นขอบ

ก.



ข.

ค.

ง.

จ.

6. หากต้องการทําให้ตารางมีรูปแบบที่สวยงามโดยเลือกใช้ลักษณะชุดตารางท่ีโปรแกรมออกแบบมาให้ ต้องใช้
คําส่ังใด

ก. Home (หน้าแรก) > Format as Table (จัดรูปแบบเป็นตาราง)
ข. Home (หน้าแรก) > Conditional Formatting (การจัดรูปแบบตามเง่ือนไข)
ค. Home (หน้าแรก) > Cell Style (สไตล์เซลล์)
ง. Home (หน้าแรก) > Insert (แทรก)
จ. Home (หน้าแรก) > Format (รูปแบบ)

7. ข้อใดเป็นสัญลักษณ์ในการคํานวณของเครื่องหมายยกกําลัง
ก. ^
ข. *
ค. /
ง. %
จ. -

8. จากสัญลักษณ์ในการคํานวณ ข้อใดเป็นความหมายของเครื่องหมาย ( )
ก. การจัดลําดับการคํานวณ
ข. ไม่เท่ากับ
ค. มากกว่าหรือเท่ากับ
ง. น้อยกว่าหรือเท่ากับ
จ. เท่ากับ

9. ข้อใดเป็นสาเหตุของข้อผิดพลาด #VALUE!
ก. เกิดจากตัวเลขท่ีพิมพ์ในเซลล์หรือผลจากสูตรในการคํานวณยาวเกินกว่าท่ีจะแสดงในเซลล์
ข. เกิดจากฟังก์ชันต้องการค่าอาร์กิวเมนต์เป็นตัวเลขแต่กลับใส่เป็นข้อความ
ค. เกิดจากการท่ีนําวันท่ีมาลบกันแล้วมีค่าติดลบ
ง. เกิดจากตัวหารมีค่าเป็น 0
จ. เกิดจากการอ้างอิงชื่อของเซลล์ (Cell) ผิด

0. ข้อใดเป็นสูตรของการหาผลรวมตั้งแต่เซลล์ A1 ถึงเซลล์ A10
ก. =SUM(A1+A10)
ข. =SUM(A1:A10)
ค. =SUM(A1-A10)
ง. =SUM(A1=A10)
จ. =SUM(A1toA10)



เฉลยข้อสอบ

ข้อท่ี เฉลย

1 เฉลยข้อ ง. Border
คําอธิบาย การจัดรูปแบบข้อมูลโดยการเรียกใช้คําสั่ง Format (รูปแบบ) ในกลุ่มของ Cells (เซลล์)

การจัดรูปแบบด้วยการใช้คําส่ังที่แท็บ Home และคลิกเลือกที่คําสั่ง Format (รูปแบบ) จะมี
คําสั่งย่อยให้เลือก Format Cells (การจัดรูปแบบเซลล์) จะปรากฏ Dialog Box ให้เลือก โดยมีแท็บ
ให้เลือกใช้งานได้ท้ังหมด 6 แท็บ

รายละเอียดของแท็บ Border

2 เฉลยข้อ ค.
คําอธิบาย การจัดให้ข้อมูลในตารางแสดงเป็นตัวหนา

เลือกคลุมข้อมูลต้ังแต่ A1:B5 จะเกิดแถบสี คลิกแท็บ Home แล้วคลิกคําสั่ง Bold (ตัวหนา)
หรือกดแป้นพิมพ์ Ctrl+B (ดังภาพ)

3 เฉลยข้อ จ.
คําอธิบาย การจัดวางข้อความ (Alignment)

การจัดวางข้อความโดยใช้แท็บ Home ในกลุ่มของ Alignment (การจัดแนว) สามารถปฏิบัติ
ได้ดังนี้

1. คลิกเลือกเซลล์ที่ต้องการกําหนดรูปแบบ
2. ค ลิกที่ แท็บ Home (หน้าแรก ) ค ลิก เลือกกลุ่ มคํ าสั่ ง Alignment (การจัดแนว)

ประกอบด้วย รายละเอียดดังนี้



TopAlign (จัดชิดด้านบน)
Middle Align (จัดตรงกลาง)
Bottom Align (จัดชิดด้านล่าง)
Orientation (การวางแนว)
Wrap Text Wrap Text (ตัดข้อความ)
Align Text Left (จัดแนวข้อความชิดซ้าย)
Center (ก่ึงกลาง)
Align Text Right (จัดแนวข้อความชิดขวา)
Decrease Indent (ลดการเยื้อง)
Increase Indent (เพิ่มการเยื้อง)
Merge & Center (ผสานและจัดกึ่งกลาง)

4 เฉลยข้อ ก.

คําอธิบาย การกําหนดเส้นขอบ (Border)
การกําหนดเส้นขอบ หรือตารางที่ผู้ใช้มองเห็นบนแผ่นงานนั้นทําให้ผู้ใช้ทํางานได้ง่ายและ

สะดวกขึ้น โดยเฉพาะการอ้างอิง แต่เมื่อผู้ใช้สั่งพิมพ์ข้อมูลออกทางเครื่องพิมพ์จะไม่ปรากฏเส้นขอบ
หรือตารางแต่อย่างใด ดังนั้นหากผู้ใช้ต้องการให้งานที่ทํามีระเบียบสวยงามและเด่นชัด ผู้ใช้สามารถ
กําหนดเส้นขอบหรือตารางโดยทําได้ท้ังจากแท็บ Home ในกลุ่มคําสั่งของ Font (แบบอักษร) หรือ
จากการคลิกขวา และจากคําสั่ง Format (รูปแบบ) ดังนี้

การกําหนดเส้นขอบโดยใช้แท็บ Home (หน้าแรก) มีดังนี้
การกําหนดเส้นขอบทําได้โดยคลิกที่แท็บ Home เลือกกลุ่มคําส่ัง Font (แบบอักษร) และ

คลิกท่ีรูปแบบ Button Borders จะปรากฏกลุ่มคําสั่งเส้นขอบให้เลือก ดังนี้



5 เฉลยข้อ ก.
คําอธิบาย การกําหนดเส้นขอบ (Border)

การกําหนดเส้นขอบ หรือตารางที่ผู้ใช้มองเห็นบนแผ่นงานนั้นทําให้ผู้ใช้ทํางานได้ง่ายและ
สะดวกขึ้น โดยเฉพาะการอ้างอิง แต่เมื่อผู้ใช้สั่งพิมพ์ข้อมูลออกทางเครื่องพิมพ์จะไม่ปรากฏเส้นขอบ
หรือตารางแต่อย่างใด ดังนั้นหากผู้ใช้ต้องการให้งานที่ทํามีระเบียบสวยงามและเด่นชัด ผู้ใช้สามารถ
กําหนดเส้นขอบหรือตารางโดยทําได้ท้ังจากแท็บ Home ในกลุ่มคําสั่งของ Font (แบบอักษร) หรือ
จากการคลิกขวา และจากคําสั่ง Format (รูปแบบ) ดังนี้

การกําหนดเส้นขอบโดยใช้แท็บ Home (หน้าแรก) มีดังนี้
การกําหนดเส้นขอบทําได้โดยคลิกที่แท็บ Home เลือกกลุ่มคําส่ัง Font (แบบอักษร) และ

คลิกท่ีรูปแบบ Button Borders จะปรากฏกลุ่มคําสั่งเส้นขอบให้เลือก ดังนี้



6 เฉลยข้อ ก. Home (หน้าแรก) > Format as Table (จัดรูปแบบเป็นตาราง)
คําอธิบาย การจัดรูปแบบด้วย AutoFormat

การจัดรูปแบบข้อมูล นอกจากจะจัดด้วยตนเองแล้วผู้ใช้ยังสามารถให้โปรแกรมจัดการรูปแบบ
ข้อมูล ให้อัตโนมัติด้วยการใช้ Table Style ซ่ึงเป็นลักษณะของชุดตารางท่ีออกแบบมาให้เลือกใช้
มากมาย โดยผู้ใช้คลิกรูปแบบท่ีตารางก็จะแสดงเปล่ียนหน้าตาให้ผู้ใช้มองเห็นทันที ซ่ึงมีวิธีปฏิบัติ
ดังนี้

1. คลิกเลือกกลุ่มเซลล์ของข้อมูลที่ต้องการจากตัวอย่าง A1:C10

2. คลิกท่ีแท็บ Home เลือกกลุ่มคําสั่ง Style (ลักษณะ) และเลือกคําสั่ง Format as Table
(จัดรูปแบบเป็นตาราง) จะปรากฏรูปแบบ ตาราง Table Style ให้เลือกตามต้องการ



3. เมื่อเลือกรูปแบบตารางแล้วจะปรากฏกล่องข้อความเพ่ือยืนยันช่วงข้อมูลที่ต้องการ
จัดรูปแบบ

(ในกรณีท่ีไม่ได้เลือกช่วงข้อมูลไว้ก่อน สามารถใส่ช่วงข้อมูลที่ต้องการจัดรูปแบบได้ในช่อง)

4. เม่ือคลิก OK จะได้ผลลัพธ์ดังภาพ

7 เฉลยข้อ ก. ^
คําอธิบาย สัญลักษณ์ท่ีใช้ในการคํานวณ

สัญลักษณ์ท่ีใช้เป็นเครื่องหมายในการคํานวณทางคณิตศาสตร์ มีดังนี้
เครื่องหมายในการคํานวณ ความหมาย

+ เครื่องหมายแทนการบวก
- เครื่องหมายแทนการลบ
* เครื่องหมายแทนการคูณ
/ เครื่องหมายแทนการหาร



% เครื่องหมายแทนเปอร์เซ็นต์
^ เครื่องหมายแทนการยกกําลัง
= เครื่องหมายเท่ากับ
> เครื่องหมายมากกว่า
< เครื่องหมายน้อยกว่า
>= เครื่องหมายมากกว่าหรือเท่ากับ
<= เครื่องหมายน้อยกว่าหรือเท่ากับ
<> เครื่องหมายไม่เท่ากับ
( ) เครื่องหมายในการจัดลําดับของการคํานวณ

8 เฉลยข้อ ก. การจัดลําดับการคํานวณ
คําอธิบาย สัญลักษณ์ท่ีใช้ในการคํานวณ

สัญลักษณ์ท่ีใช้เป็นเครื่องหมายในการคํานวณทางคณิตศาสตร์ มีดังนี้
เครื่องหมายในการคํานวณ ความหมาย

+ เครื่องหมายแทนการบวก
- เครื่องหมายแทนการลบ
* เครื่องหมายแทนการคูณ
/ เครื่องหมายแทนการหาร
% เครื่องหมายแทนเปอร์เซ็นต์
^ เครื่องหมายแทนการยกกําลัง
= เครื่องหมายเท่ากับ
> เครื่องหมายมากกว่า
< เครื่องหมายน้อยกว่า
>= เครื่องหมายมากกว่าหรือเท่ากับ
<= เครื่องหมายน้อยกว่าหรือเท่ากับ
<> เครื่องหมายไม่เท่ากับ
( ) เครื่องหมายในการจัดลําดับของการคํานวณ

9 เฉลยข้อ ข. เกิดจากฟังก์ชันต้องการค่าอาร์กิวเมนต์เป็นตัวเลขแต่กลับใส่เป็นข้อความ
คําอธิบาย ข้อผิดพลาดท่ีอาจเกิดขึ้นในการกําหนดฟังก์ชันและสูตร

ความผิดพลาดของสูตรคํานวณ (Error Message) เมื่อมีการทํางานเกี่ยวกับสูตรหรือฟังก์ชัน
อาจเกิดข้อผิดพลาดต่าง ๆ ในระหว่างการคํานวณทําให้ได้ผลลัพธ์ไม่ถูกต้อง และจะแสดงข้อความบ่ง
บอกถึงความผิดพลาดปรากฏอยู่ในเซลล์ซ่ึงมีสาเหตุหลายอย่างด้วยกัน ดังรายละเอียดต่อไปนี้

ข้อความผิดพลาด สาเหตุ
# # # # # # # • ตัวเลขที่พิมพ์ในเซลล์ หรือผลจากสูตรในการคํานวณยาวเกินกว่าท่ี

จะแสดงในเซลล์
• เกิดจากการท่ีนําวันท่ีมาลบกันแล้วมีค่าติดลบ

#DIV/0 • เกิดจากตัวหารมีค่าเป็น 0 คือ ตัวหารเป็นเซลล์ว่าง ๆ หรือค่าอาร์กิ
วเมนต์ ของบางฟังก์ชันมีค่าไม่ถูกต้อง

#VALUE! • เกิดจากการใช้ Operand หรืออาร์ กิวเมนต์ผิดประเภท เช่น



ฟังก์ชันต้องการค่าอาร์กิวเมนต์เป็นตัวเลขแต่กลับใส่เป็นข้อความ
#NAME? • เกิดจากการอ้างอิงชื่อของเซลล์ (Cell) ผิด

• พิมพ์ช่ือของฟังก์ชันท่ีใช้ในสูตรไม่ถูกต้อง
• เมื่อมีการอ้างอิงถึงเซลล์เป็นช่วงแต่ไม่ใส่เครื่องหมาย : เช่น
(A1:A5) • เม่ือมีการใช้ข้อความในสูตรแล้วไม่ใส่เครื่องหมาย “ ”
คร่อมข้อความนั้น

#N/A (Not Available) • เกิดจากการใส่อาร์กิวเมนต์ให้ฟังก์ชันไม่ครบหรือใช้ค่าอาร์กิวเมนต์
ท่ีไม่ถูกกับฟังก์ชัน

#REF! • เกิดจากเซลล์ท่ีอ้างอิงถึงในสูตรถูกลบออกไปหรือถูกข้อมูลจาก
เซลล์อ่ืนย้ายมาทับแทนท่ี
• มีการอ้างอิงถึงข้อมูลของโปรแกรมอื่นท่ีไม่ได้กําลังทํางานอยู่
ขณะนั้น

#NUM • กําหนดอาร์กิวเมนต์ผิดพลาดผิดประเภทที่เก่ียวกับตัวเลขอาจ
กําหนดเป็นชนิดข้อมูลอ่ืน
• ผลของสูตรคํานวณที่ได้จากตัวเลขมีค่ามากหรือน้อยเกินไป

#NULL • เกิดจากการกําหนด Cell Reference ผิดพลาด
10 เฉลยข้อ ข. =SUM(A1:A10)

คําอธิบาย SUM (การหาผลรวมของข้อมูล)
รูปแบบ =SUM(Number 1, Number 2, ...)
Number เป็นกลุ่มของข้อมูลที่ต้องการหาผลรวมซึ่งสามารถจะใส่ได้มากกว่า 1 กลุ่มโดยใช้

เครื่องหมาย , คั่นกลางระหว่างแต่ละกลุ่มข้อมูล เช่น ให้หาผลรวมตั้งแต่เซลล์ A1 ถึงเซลล์ A10
ตัวอย่าง =SUM(A1:A10)



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 6
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 11-12

ช่ือหน่วยการเรียนรู้ การเรียงลําดับ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การเรียงลําดับ

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.การจัดเรียงข้อมูล (Sorting)
2.การใช้ตัวกรองข้อมูล (Filtering)

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงการจัดเรียง คัดกรองข้อมูลโดยใช้โปรแกรม Microsot Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.จัดเรียงข้อมูล (Sorting) ใด้
2.ใช้ตัวกรองข้อมูล (Filtering) ใด้

5. สาระการเรียนรู้
1.วิธีการคํานวณ
2.สัญลักษณ์ท่ีใช้ในการคํานวณ
3.ข้อผิดพลาดท่ีอาจเกิดขึ้นในการกําหนดฟังก์ชันและสูตร
4.ประเภทของฟังก์ชันและฟังก์ชันที่ใช้งาน
5.การอ้างอิงเซลล์

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0
50-54 1



55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน



1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 6 หน่วยที่ 6
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 11-12

ช่ือหน่วยการเรียนรู้ การเรียงลําดับ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การเรียงลําดับ

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
โปรแกรม Microsoft Excel 2016 เป็นโปรแกรม ท่ีเหมาะกับงานคํานวณดังที่ได้กล่าวมาแล้วไม่ว่าจะเป็น

งานบัญชี งานการเงิน งานวัดผล และงานคํานวณท่ัวไป การคํานวณทําได้ทั้งการํานวณอย่างง่ายจนถึงการคํานวณ
แบบสลับซับซ้อนเพียงผู้ใช้กําหนดสูตรตามต้องการและสามารถคัดลอกสูตรไปใช้ในงานลักษณะเดียวกันได้อีก โดย
ไม่ต้องเสียเวลากําหนดสูตรใหม่
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงการจัดเรียง คัดกรองข้อมูลโดยใช้โปรแกรม Microsot Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.จัดเรียงข้อมูล (Sorting) ใด้
2.ใช้ตัวกรองข้อมูล (Filtering) ใด้

5.เน้ือหาสาระ













6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 6 หน่วยที่ 6
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 11-12

ช่ือหน่วยการเรียนรู้ การเรียงลําดับ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือ การเรียงลําดับ

แบบฝึกหัด
1. จากสูตร =AVERAGE(B2:B6) เป็นฟังก์ชั่นการหาค่าอะไร

ก. การหาค่าสูงสุดของจํานวน
ข. การหาค่าต่ําสุดของจํานวน
ค. การหาค่าเฉลี่ยของข้อมูล
ง. การหาค่ากลาง
จ. การหาค่าเบี่ยงเบนมาตรฐาน

2. ข้อใดเป็นสูตรของฟังก์ชันการนับข้อมูลที่เป็นเฉพาะตัวเลข
ก. =COUNTIF(Range, Criteria)
ข. =COUNTA(Value1, Value2, ...)
ค. =COUNT(Value1, Value2, ...)
ง. =STDEV(Number1, Number2, ...)
จ. =ROUND(Number, Num_digits)

3. ฟังก์ชัน IF ใช้สําหรับการคํานวณใด
ก. ใช้สําหรับการคํานวณหาค่ากลางของข้อมูล
ข. ใช้สําหรับการคํานวณท่ีมีการกําหนดเง่ือนไข
ค. ใช้สําหรับการคํานวณหาค่าเฉลี่ยของข้อมูล
ง. ใช้สําหรับการนับจํานวนข้อมูลที่เป็นเฉพาะตัวเลข
จ. ใช้สําหรับการนับจํานวนข้อมูลที่เป็นท้ังข้อความและตัวเลขปนกัน

4. ข้อใดเป็นคีย์ลัดสําหรับการแทรกฟังก์ชัน
ก. Shift+F1
ข. Shift+F2
ค. Shift+F3
ง. Shift+F4
จ. Shift+F5

จากภาพ ใช้ตอบคําถามข้อ 55-57



5. ข้อใดเป็นการกําหนดสูตรในเซลล์ B12
ก. =AVERAGE(A4:A10)
ข. =AVERAGE(B4:B10)
ค. =SUM(A4:A10)
ง. =SUM(B4:B10)
จ. =MAX(B4:B10)

6. ข้อใดเป็นการกําหนดสูตรในเซลล์ B13
ก. =AVERAGE(A4:A10)
ข. =AVERAGE(B4:B10)
ค. =SUM(A4:A10)
ง. =SUM(B4:B10)
จ. =MAX(B4:B10)

7. ข้อใดเป็นการกําหนดสูตรในเซลล์ B14
ก. =AVERAGE(A4:A10)
ข. =AVERAGE(B4:B10)
ค. =SUM(A4:A10)
ง. =SUM(B4:B10)
จ. =MAX(B4:B10)

8. ข้อใดคือคําสั่งท่ีใช้ในการเรียงลําดับข้อมูล
ก. Data > Sort…
ข. Data > Custom
ค. Data > Filter
ง. Data > AutoFilter
จ. Data > Order

จากภาพ ใช้ตอบคําถามข้อ 59-60

9. หากต้องการเรียงลําดับข้อมูลของคอลัมน์อายุ (Age) สามารถเลือกเซลล์ใดได้บ้าง
ก. A1:A6
ข. B2:B6
ค. C1:C6
ง. E1:E6
จ. F2:F6

10. หากต้องการเรียงลําดับข้อมูลของคอลัมน์เงินเดือน (Salary) สามารถเลือกเซลล์ใดได้บ้าง
ก. A1:A6
ข. B1:B6



ค. C1:C6
ง. E1:E6
จ. F1:F6



เฉลยข้อสอบ

ข้อท่ี เฉลย

1 เฉลยข้อ ค. การหาค่าเฉลี่ยของข้อมูล
คําอธิบาย AVERAGE (การหาค่าเฉลี่ยของข้อมูล)

รูปแบบ
=AVERAGE(Number1, Number2, ...) Number เป็นกลุ่มของข้อมูลที่ต้องการหาค่าเฉล่ีย

เช่น ให้หาค่าเฉลี่ยของเซลล์ F1 ถึงเซลล์ F8 ตัวอย่าง =AVERAGE(F1:F8)
2 เฉลยข้อ ค. =COUNT(Value1, Value2, ...)

คําอธิบาย COUNT (การนับจํานวนข้อมูลที่เป็นเฉพาะตัวเลข)
รูปแบบ =COUNT(Value1, Value2, ...)
Value ช่วงของกลุ่มเซลล์ที่นํามาใช้ในการนับจํานวน เช่น ให้นับจํานวนรหัสนักเรียนว่ามีกี่คน

โดยอ้างท่ีเซลล์ C2 ถึงเซลล์ C10 ตัวอย่าง =COUNT(C2:C10)
3 เฉลยข้อ ข. ใช้สําหรับการคํานวณท่ีมีการกําหนดเง่ือนไข

คําอธิบาย IF (การหาค่าจริงหรือเท็จจากเง่ือนไขที่ระบุ)
รูปแบบ
=IF(Logical,Value_if_true, Value_if_false)
Logical เง่ือนไขท่ีใช้ในการเปรียบเทียบหรือตรวจสอบข้อมูล
Value_if_true ค่าของเง่ือนไขท่ีถูกต้อง (จริง)
Value_if_false ค่าของเง่ือนไขท่ีไม่ถูกต้อง (เท็จ)
เช่น ถ้าที่เซลล์ B2 มากกว่าหรือเท่ากับ 60 ให้แสดงผ่าน ถ้าที่เซลล์ B2 น้อยกว่า 60 ให้

แสดงไม่ผ่าน ตัวอย่าง =IF(B2>=60"ผ่าน" "ไม่ผ่าน")
4 เฉลยข้อ ค. Shift+F3

คําอธิบาย การเขียนฟังก์ชันโดยใช้แท็บ Formulas (สูตร) เลือกคําส่ัง Insert Function (แทรก
ฟังก์ชัน)

การใช้คําสั่ง Insert Function (แทรกฟังก์ชัน) ส่วนใหญ่ผู้ใช้จะใช้เมื่อจําฟังก์ชันไม่ได้ หรือไม่
ค่อยได้ใช้ฟังก์ชันนั้นบ่อย ๆ มีวิธีการปฏิบัติดังนี้

1. คลิกเลือกเซลล์ที่ต้องการใส่ฟังก์ชัน

2. คลิกท่ีคําส่ัง Insert Function (แทรกฟังก์ชัน) หรือกด Shift+F3



จะปรากฏ Dialog Box โดยมีรายละเอียดดังนี้

• Search for a function : เลือกฟังก์ชันโดยการค้นหาจากคําท่ีต้องการ
• Or select a category : หรือเลือกประเภทของฟังก์ชัน
• Select a function : เลือกรูปแบบฟังก์ชันที่ต้องการคํานวณ
ในกรณีนี้เป็นการใช้ฟังก์ชันเพ่ือหาสินค้าที่มีราคาสูงสุด จึงเลือกใช้ฟังก์ชัน MAX
3. คลิก OK จะปรากฏ Dialog Box สําหรับใส่ช่วงข้อมูลสําหรับการคํานวณ
4. ท่ีช่อง Number1 ในโปรแกรม Microsoft Excel 2016 จะใส่ชื่อของเซลล์มาให้โดย

อัตโนมัติ แต่ถ้าหากไม่ตรงหรือไม่ถูกต้องตามที่ต้องการ ให้ใช้เมาส์คลิกเลือกเซลล์ที่จะนํามาคํานวณ
หรือพิมพ์ด้วยตนเอง

5. หากยังมีการคํานวณอีกก็ให้ใส่ในช่องถัดไป อาจจะใช้วิธีการพิมพ์ช่ือเซลล์หรือการใช้เมาส์
คลิกเลือกเซลล์เองก็ได้

6. คลิก OK จะได้ผลลัพธ์ดังภาพ

5 เฉลยข้อ ง. =SUM(B4:B10)
คําอธิบาย เซลล์ B12 เป็นยอดจ่ายรวมท้ังหมดของเงินเดือน ซ่ึงเป็นการหาผลรวมของข้อมูล

SUM (การหาผลรวมของข้อมูล)
รูปแบบ =SUM(Number 1, Number 2, ...)
Number เป็นกลุ่มของข้อมูลที่ต้องการหาผลรวมซึ่งสามารถจะใส่ได้มากกว่า 1 กลุ่มโดยใช้

เครื่องหมาย , คั่นกลางระหว่างแต่ละกลุ่มข้อมูล เช่น ให้หาผลรวมตั้งแต่เซลล์ A1 ถึงเซลล์ A10
ตัวอย่าง =SUM(A1:A10)

6 เฉลยข้อ ข. =AVERAGE(B4:B10)



คําอธิบาย เซลล์ B13 เป็นยอดของเงินเดือนเฉลี่ย ซ่ึงเป็นการหาค่าเฉลี่ยของข้อมูล
AVERAGE (การหาค่าเฉลี่ยของข้อมูล)
รูปแบบ
=AVERAGE(Number1, Number2, ...) Number เป็นกลุ่มของข้อมูลที่ต้องการหาค่าเฉล่ีย

เช่น ให้หาค่าเฉลี่ยของเซลล์ F1 ถึงเซลล์ F8 ตัวอย่าง =AVERAGE(F1:F8)
7 เฉลยข้อ จ. =MAX(B4:B10)

คําอธิบาย เซลล์ B14 เป็นยอดของเงินเดือนท่ีเยอะท่ีสุด ซ่ึงเป็นการหาค่าสูงสุดของจํานวน
MAX (การหาค่าสูงสุดของจํานวน)
รูปแบบ
=MAX(Number1, Number2, ...)
Number เป็นกลุ่มของข้อมูลที่ต้องการหาค่าสูงสุด เช่น ให้หาค่าสูงสุดของเซลล์ B2 ถึงเซลล์

F2
ตัวอย่าง =MAX(B2:F2)

8 เฉลยข้อ ก. Data > Sort…
คําอธิบาย การจัดเรียงข้อมูล (Sorting)

การจัดเรียงข้อมูล คือ การจัดข้อมูลให้เป็นระเบียบเรียบร้อยเพื่อความสะดวกในการค้นหา
และใช้งาน การจัดเรียงข้อมูลมี 2 ลักษณะ คือ เรียงจากน้อยที่สุดไปหามากที่สุด (A to Z) และเรียง
จากมากที่สุดไปหาน้อยท่ีสุด (Z to A) โดยผู้ใช้สามารถจัดเรียงข้อมูลได้หลาย ๆ ฟิลด์

การจัดเรียงข้อมูลโดยใช้ข้อมูลฟิลด์เดียว
การจัดเรียงข้อมูลฟิลด์เดียวมีข้ันตอนดังนี้
1. นํา Cell Pointer คลิกในคอลัมน์ที่ต้องการจัดเรียง โดยสามารถคลิกที่เซลล์ใดก็ได้ใน

คอลัมน์
2. คลิกเลือกท่ีแท็บ Data (ข้อมูล) คลิกคําสั่ง Sort (การเรียงลําดับ) โดย

Sort A to Z หมายถึงการเรียงลําดับจากน้อยท่ีสุดไปหามากท่ีสุด
Sort Z to A หมายถึงการเรียงลําดับจากมากที่สุดไปหาน้อยท่ีสุด

9 เฉลยข้อ ง. E1:E6
คําอธิบาย การจัดเรียงข้อมูลโดยใช้ข้อมูลฟิลด์เดียว การจัดเรียงข้อมูลฟิลด์เดียวมีข้ันตอนดังนี้

1. นํา Cell Pointer คลิกในคอลัมน์ที่ต้องการจัดเรียง โดยสามารถคลิกที่เซลล์ใดก็ได้ใน
คอลัมน์

2. คลิกเลือกท่ีแท็บ Data (ข้อมูล) คลิกคําสั่ง Sort (การเรียงลําดับ) โดย
Sort A to Z หมายถึงการเรียงลําดับจากน้อยท่ีสุดไปหามากท่ีสุด
Sort Z to A หมายถึงการเรียงลําดับจากมากที่สุดไปหาน้อยท่ีสุด

10 เฉลยข้อ จ. F1:F6
คําอธิบาย การจัดเรียงข้อมูลโดยใช้ข้อมูลฟิลด์เดียว การจัดเรียงข้อมูลฟิลด์เดียวมีข้ันตอนดังนี้

1. นํา Cell Pointer คลิกในคอลัมน์ที่ต้องการจัดเรียง โดยสามารถคลิกที่เซลล์ใดก็ได้ใน
คอลัมน์

2. คลิกเลือกท่ีแท็บ Data (ข้อมูล) คลิกคําสั่ง Sort (การเรียงลําดับ) โดย
Sort A to Z หมายถึงการเรียงลําดับจากน้อยท่ีสุดไปหามากท่ีสุด



Sort Z to A หมายถึงการเรียงลําดับจากมากที่สุดไปหาน้อยท่ีสุด

บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน



มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน
1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 7
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 13-14

ช่ือหน่วยการเรียนรู้ การสรุปและนําเสนอข้อมูลในรูปแผนภูมิ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การสรุปและนําเสนอข้อมูลในรูปแผนภูมิ

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.การจัดเรียงข้อมูล (Sorting)
2.การใช้ตัวกรองข้อมูล (Filtering)

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงการจัดเรียง คัดกรองข้อมูลโดยใช้โปรแกรม Microsot Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.จัดเรียงข้อมูล (Sorting) ใด้
2.ใช้ตัวกรองข้อมูล (Filtering) ใด้

5. สาระการเรียนรู้
1.วิธีการคํานวณ
2.สัญลักษณ์ท่ีใช้ในการคํานวณ
3.ข้อผิดพลาดท่ีอาจเกิดขึ้นในการกําหนดฟังก์ชันและสูตร
4.ประเภทของฟังก์ชันและฟังก์ชันที่ใช้งาน
5.การอ้างอิงเซลล์

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0
50-54 1



55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน



1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 7 หน่วยที่ 7
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 13-14

ช่ือหน่วยการเรียนรู้ การสรุปและนําเสนอข้อมูลในรูปแผนภูมิ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การสรุปและนําเสนอข้อมูลในรูปแผนภูมิ

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
โปรแกรม Microsoft Excel 2016 เป็นโปรแกรม ท่ีเหมาะกับงานคํานวณดังที่ได้กล่าวมาแล้วไม่ว่าจะเป็น

งานบัญชี งานการเงิน งานวัดผล และงานคํานวณท่ัวไป การคํานวณทําได้ทั้งการํานวณอย่างง่ายจนถึงการคํานวณ
แบบสลับซับซ้อนเพียงผู้ใช้กําหนดสูตรตามต้องการและสามารถคัดลอกสูตรไปใช้ในงานลักษณะเดียวกันได้อีก โดย
ไม่ต้องเสียเวลากําหนดสูตรใหม่
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงการจัดเรียง คัดกรองข้อมูลโดยใช้โปรแกรม Microsot Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.จัดเรียงข้อมูล (Sorting) ใด้
2.ใช้ตัวกรองข้อมูล (Filtering) ใด้

5.เน้ือหาสาระ



































6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 7 หน่วยที่ 7
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 13-14

ช่ือหน่วยการเรียนรู้ การสรุปและนําเสนอข้อมูลในรูปแผนภูมิ
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือ การสรุปและนําเสนอข้อมูลในรูปแผนภูมิ

แบบฝึกหัด

1. จากข้อมูลมีการเรียงลําดับสิ่งใดเป็นลําดับแรก
ก. No.
ข. Std.Id
ค. Name
ง. Age
จ. Salary

2. จากข้อมูลมีการเรียงลําดับสิ่งใดเป็นลําดับถัดมา
ก. No.
ข. Std.Id
ค. Name
ง. Age
จ. Salary

3. จากข้อมูลเป็นการเรียงลําดับด้วยสิ่งใด
ก. ค่าของข้อมูล
ข. สีของเซลล์
ค. สีของแบบอักษร
ง. ไอคอนของเซลล์
จ. ชื่อของเซลล์

4. จากตัวเลือก Number Filters ข้อใดเป็นคําสั่งของการกรองเฉพาะข้อมูลท่ีมีค่าเท่ากับท่ีตั้งไว้
ก. Greater Than
ข. Between
ค. Equal
ง. Top10
จ. Above Average

5. ข้อใดเป็นผลของคําสั่ง Less Than or Equal to ของตัวเลือก Number Filters
ก. กรองเฉพาะข้อมูลท่ีมีค่าเท่ากับที่ตั้งไว้
ข. กรองเฉพาะข้อมูลท่ีมีค่าไม่เท่ากับท่ีตั้งไว้
ค. กรองเฉพาะข้อมูลท่ีมีค่าอยู่ในช่วงท่ีตั้งไว้
ง. กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าหรือเท่ากับท่ีตั้งไว้
จ. กรองเฉพาะข้อมูลท่ีมีค่ามากกว่าที่ตั้งไว้



6. ข้อใดเป็นผลจากการเลือกตัวเลือก Item ของตัวกรองตัวเลขแบบ Top10
ก. แสดงข้อมูลท่ีมีค่ามากท่ีสุดตามจํานวนที่กําหนด
ข. แสดงข้อมูลท่ีมีค่าน้อยที่สุดตามจํานวนท่ีกําหนด
ค. กําหนดจํานวนหรือเปอร์เซ็นต์ของข้อมูล
ง. แสดงข้อมูลตามจํานวนท่ีกําหนด
จ. แสดงข้อมูลตามเปอร์เซ็นต์ที่กําหนด

7. ข้อใดเป็นผลลัพธ์ของภาพด้านบน

ก.

ข.

ค.

ง.



จ.

8. ข้อใดเป็นผลของคําสั่ง Does Not Contain.... ของตัวเลือก Text Filters (ตัวกรองข้อความ)
ก. กรองเฉพาะคําที่เริ่มต้นข้อความด้วยตัวอักษรท่ีกําหนด
ข. กรองเฉพาะคําที่ลงท้ายด้วยข้อความด้วยตัวอักษรท่ีกําหนด
ค. กรองเฉพาะคําที่ไม่มีตัวอักษรท่ีกําหนดอยู่ในข้อความ
ง. กรองเฉพาะคําที่ตัวอักษรเหมือนกับที่กําหนด
จ. กรองเฉพาะคําที่ตัวอักษรไม่เหมือนกับที่กําหนด

9. ข้อใดกล่าวถูกต้องเกี่ยวกับการสร้างแผนภูมิหรือกราฟ
ก. เป็นการนําข้อมูลชนิดตัวเลขมาจัดให้อยู่ในลักษณะของภาพ
ข. สามารถมองเห็นข้อมูลในลักษณะของการเปรียบเทียบ
ค. ทําให้ดูน่าสนใจและทําให้ผู้ใช้ข้อมูลเข้าใจความหมายได้ง่ายข้ึน
ง. ช่วยในการนําเสนอข้อมูลท่ียุ่งยากสลับซับซ้อน
จ. ถูกทุกข้อ

10. ข้อใดเป็นชุดคําสั่งย่อยในการสร้างแผนภูมิ

ก.

ข.

ค.

ง.

จ.



เฉลยข้อสอบ

ข้อท่ี เฉลย

เฉลยข้อ ง. Age
คําอธิบาย

จากรูปจะเห็นว่าข้อมูลมีการจัดเรียงตามลําดับอายุจากน้อยไปมากก่อน หากข้อมูลใดมีค่าอายุ
เท่ากัน จึงจะทําการจัดเรียงตามลําดับเงินเดือนจากน้อยไปมากต่อไป
เฉลยข้อ จ. Salary
คําอธิบาย

จากรูปจะเห็นว่าข้อมูลมีการจัดเรียงตามลําดับอายุจากน้อยไปมากก่อน หากข้อมูลใดมีค่าอายุ
เท่ากัน จึงจะทําการจัดเรียงตามลําดับเงินเดือนจากน้อยไปมากต่อไป



เฉลยข้อ ก. ค่าของข้อมูล
คําอธิบาย

Column คอลัมน์ (จะมีช่อง Sort by (เรียงลําดับตาม) จะมีช่องให้คลิกเลือกท่ีรูปแบบ
Drop Down List จะแสดงชื่อฟิลด์ของตารางข้อมูลทุกชื่อฟิลด์)

Sort On เรียงลําดับ (จะมีช่องให้คลิกเลือกที่ รูปแบบ Drop Down List) ซ่ึงจะแสดง
รายละเอียดให้เลือกดังนี้

- Values ค่าของข้อมูล
- Cell Color สีของเซลล์
- Font Color สีแบบอักษร
- Cell Icon ไอคอนของเซลล์

Order ลําดับ (จะมีช่องให้คลิกเลือกที่รูปแบบ DropDownList) ซึ่งจะแสดง
รายละเอียดให้เลือกดังนี้

- Smallest to Largest น้อยท่ีสุดไปหามากที่สุด
- Largest to Smallest มากท่ีสุดไปหาน้อยที่สุด
- Custom List… รายการแบบกําหนดเอง

เฉลยข้อ ค. Equal
คําอธิบาย รายละเอียดของตัวเลือก Number Filters (ตัวกรองตัวเลข) มีดังนี้
Equal กรองเฉพาะข้อมูลท่ีมีค่าเท่ากับที่ตั้งไว้
Does Not Equal กรองเฉพาะข้อมูลท่ีมีค่าไม่เท่ากับท่ีตั้งไว้
Greater Than กรองเฉพาะข้อมูลท่ีมีค่ามากกว่าที่ตั้งไว้
Greater Than or Equal to Less Than กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าท่ีตั้งไว้
Less Than or Equal to กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าหรือเท่ากับท่ีตั้งไว้
Between กรองเฉพาะข้อมูลท่ีมีค่าอยู่ในช่วงท่ีตั้งไว้
Top 10 กรองเฉพาะข้อมูลท่ีมีค่าอยู่ใน 10 อันดับแรก
Above Average กรองเฉพาะข้อมูลท่ีมีค่ามากกว่าค่าเฉลี่ย
Below Average กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าค่าเฉลี่ย
Custom Filter ใช้ตัวกรองแบบกําหนดเอง
เฉลยข้อ ง. กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าหรือเท่ากับท่ีตั้งไว้
คําอธิบาย รายละเอียดของตัวเลือก Number Filters (ตัวกรองตัวเลข) มีดังนี้
Equal กรองเฉพาะข้อมูลท่ีมีค่าเท่ากับที่ตั้งไว้
Does Not Equal กรองเฉพาะข้อมูลท่ีมีค่าไม่เท่ากับท่ีตั้งไว้



Greater Than กรองเฉพาะข้อมูลท่ีมีค่ามากกว่าที่ตั้งไว้
Greater Than or Equal to Less Than กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าท่ีตั้งไว้
Less Than or Equal to กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าหรือเท่ากับท่ีตั้งไว้
Between กรองเฉพาะข้อมูลท่ีมีค่าอยู่ในช่วงท่ีตั้งไว้
Top 10 กรองเฉพาะข้อมูลท่ีมีค่าอยู่ใน 10 อันดับแรก
Above Average กรองเฉพาะข้อมูลท่ีมีค่ามากกว่าค่าเฉลี่ย
Below Average กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าค่าเฉลี่ย
Custom Filter ใช้ตัวกรองแบบกําหนดเอง
เฉลยข้อ ง. แสดงข้อมูลตามจํานวนท่ีกําหนด
คําอธิบาย Top 10 (10 อันดับแรก) รายละเอียดของตัวเลือกต่าง ๆ มีดังนี้
ตัวเลือก Top (บน) แสดงข้อมูลท่ีมีค่ามากท่ีสุดตามจํานวนที่กําหนด

Bottom (ล่าง) แสดงข้อมูลท่ีมีค่าน้อยที่สุดตามจํานวนท่ีกําหนด
ตัวเลข กําหนดจํานวนหรือเปอร์เซ็นต์ของข้อมูล
Item แสดงข้อมูลตามจํานวนท่ีกําหนด
Percent แสดงข้อมูลตามเปอร์เซ็นต์ที่กําหนด

เฉลยข้อ ข.

คําอธิบาย Equal เป็นการกรองเฉพาะข้อมูลที่มีค่าเท่ากับที่ต้ังไว้ ซึ่งจากโจทย์ให้กรองข้อมูลอายุที่
เท่ากับ 21

เฉลยข้อ ค. กรองเฉพาะคําที่ไม่มีตัวอักษรท่ีกําหนดอยู่ในข้อความ
คําอธิบาย Text Filters (ตัวกรองข้อความ) จะมีคําสั่งย่อยให้เลือกดังนี้

- Equals... ตัวอักษรเหมือนกับท่ีกําหนด
- Does Not Equal... ตัวอักษรไม่เหมือนกับท่ีกําหนด
- Begins With... เริ่มต้นข้อความด้วยตัวอักษรท่ีกําหนด
- Ends With... ลงท้ายด้วยข้อความด้วยตัวอักษรท่ีกําหนด
- Contains มีตัวอักษรท่ีกําหนดอยู่ในข้อความ
- Does Not Contain.... ไม่มีตัวอักษรที่กําหนดอยู่ในข้อความ
- Custom Filter... ตัวกรองแบบกําหนดเอง

เฉลยข้อ จ. ถูกทุกข้อ
คําอธิบาย การสร้างแผนภูมิ (Chart) หรือกราฟ (Graph) เป็นการนําข้อมูลชนิดตัวเลขมาจัดให้อยู่
ในลักษณะของภาพท่ีสามารถมองเห็นข้อมูลในลักษณะของการเปรียบเทียบ และทําให้ดูน่าสนใจ



มากขึ้น ซึ่งทําให้ผู้ใช้ข้อมูลเข้าใจความหมายได้ง่ายข้ึน โดยเฉพาะการนําเสนอข้อมูลที่ยุ่งยาก
สลับซับซ้อน
เฉลยข้อ ค.

คําอธิบาย เป็นกลุ่มคําสั่งในการสร้าง Chart (แผนภูมิ) อยู่ในแท็บเมนู Insert (แทรก)



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 8
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่15-16
ช่ือหน่วยการเรียนรู้ การสรุปและนําเสนอข้อมูลในรูปตารางวิเคราะห์
ข้อมูล

ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งานการสรุปและนําเสนอข้อมูลในรูปตารางวิเคราะห์ข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.เครื่องมือในการจัดการตารางวิเคราะห์ข้อมูล
2.ส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูล
3.การสร้างตารางวิเคราะหข้์อมูล
4.การตกแต่งตารางวิเคราะห์ข้อมูล

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงการสร้างตารางวิเคราะหข้์อมูลโดยใช้โปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.อธิบายเครื่องมือในการจัดการตารางวิเคราะห์ข้อมูลได้
2.บอกส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูลได้
3.สร้างตารางวิเคราะห์ข้อมูลได้
4.ตกแต่งตารางวิเคราะห์ข้อมูลได้

5. สาระการเรียนรู้
1.เครื่องมือในการจัดการตารางวิเคราะห์ข้อมูล
2.ส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูล
3.การสร้างตารางวิเคราะหข้์อมูล
4.การตกแต่งตารางวิเคราะห์ข้อมูล

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้



คะแนน เกรด
0-49 0
50-54 1
55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล



2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 8 หน่วยที่ 8
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่15-16
ช่ือหน่วยการเรียนรู้ การสรุปและนําเสนอข้อมูลในรูปตารางวิเคราะห์
ข้อมูล

ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การสรุปและนําเสนอข้อมูลในรูปตารางวิเคราะห์ข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
การสร้างตารางวิเคราะห์ข้อมูล (PivotTable) เป็นการวิเคราะห์เพื่อหาผลสรุปของข้อมูล โดยสามารถ ปรับ

มุมมองของข้อมูลใหม่ได้โดยผูใ้ชเ้พียงคลิกแล้วลาก เพื่อเปลีย่นตําแหน่งของหัวข้อต่าง ๆ ให้เหมาะสมมากขึน้ตาม
ความตอ้งการ
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงการสร้างตารางวิเคราะหข้์อมูลโดยใช้โปรแกรม Microsoft Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.อธิบายเครื่องมือในการจัดการตารางวิเคราะห์ข้อมูลได้
2.บอกส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูลได้
3.สร้างตารางวิเคราะห์ข้อมูลได้
4.ตกแต่งตารางวิเคราะห์ข้อมูลได้

5.เน้ือหาสาระ

















6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 9 หน่วยที่ 9
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่17
ช่ือหน่วยการเรียนรู้ การสรุปและนําเสนอข้อมูลในรูปตารางวิเคราะห์
ข้อมูล

ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือการสรุปและนําเสนอข้อมูลในรูปตารางวิเคราะห์ข้อมูล

แบบฝึกหัด

1. จากข้อมูลมีการเรียงลําดับสิ่งใดเป็นลําดับแรก
ก. No.
ข. Std.Id
ค. Name
ง. Age
จ. Salary

2. จากข้อมูลมีการเรียงลําดับสิ่งใดเป็นลําดับถัดมา
ก. No.
ข. Std.Id
ค. Name
ง. Age
จ. Salary

3. จากข้อมูลเป็นการเรียงลําดับด้วยสิ่งใด
ก. ค่าของข้อมูล
ข. สีของเซลล์
ค. สีของแบบอักษร
ง. ไอคอนของเซลล์
จ. ชื่อของเซลล์

4. จากตัวเลือก Number Filters ข้อใดเป็นคําสั่งของการกรองเฉพาะข้อมูลท่ีมีค่าเท่ากับท่ีตั้งไว้
ก. Greater Than
ข. Between
ค. Equal
ง. Top10
จ. Above Average

5. ข้อใดเป็นผลของคําสั่ง Less Than or Equal to ของตัวเลือก Number Filters
ก. กรองเฉพาะข้อมูลท่ีมีค่าเท่ากับที่ตั้งไว้
ข. กรองเฉพาะข้อมูลท่ีมีค่าไม่เท่ากับท่ีตั้งไว้
ค. กรองเฉพาะข้อมูลท่ีมีค่าอยู่ในช่วงท่ีตั้งไว้
ง. กรองเฉพาะข้อมูลท่ีมีค่าน้อยกว่าหรือเท่ากับท่ีตั้งไว้
จ. กรองเฉพาะข้อมูลท่ีมีค่ามากกว่าที่ตั้งไว้



6. ข้อใดเป็นผลจากการเลือกตัวเลือก Item ของตัวกรองตัวเลขแบบ Top10
ก. แสดงข้อมูลท่ีมีค่ามากท่ีสุดตามจํานวนที่กําหนด
ข. แสดงข้อมูลท่ีมีค่าน้อยที่สุดตามจํานวนท่ีกําหนด
ค. กําหนดจํานวนหรือเปอร์เซ็นต์ของข้อมูล
ง. แสดงข้อมูลตามจํานวนท่ีกําหนด
จ. แสดงข้อมูลตามเปอร์เซ็นต์ที่กําหนด

7. ข้อใดเป็นผลลัพธ์ของภาพด้านบน

ก.

ข.

ค.

ง.



จ.

8. ข้อใดเป็นผลของคําสั่ง Does Not Contain.... ของตัวเลือก Text Filters (ตัวกรองข้อความ)
ก. กรองเฉพาะคําที่เริ่มต้นข้อความด้วยตัวอักษรท่ีกําหนด
ข. กรองเฉพาะคําที่ลงท้ายด้วยข้อความด้วยตัวอักษรท่ีกําหนด
ค. กรองเฉพาะคําที่ไม่มีตัวอักษรท่ีกําหนดอยู่ในข้อความ
ง. กรองเฉพาะคําที่ตัวอักษรเหมือนกับที่กําหนด
จ. กรองเฉพาะคําที่ตัวอักษรไม่เหมือนกับที่กําหนด

9. ข้อใดกล่าวถูกต้องเกี่ยวกับการสร้างแผนภูมิหรือกราฟ
ก. เป็นการนําข้อมูลชนิดตัวเลขมาจัดให้อยู่ในลักษณะของภาพ
ข. สามารถมองเห็นข้อมูลในลักษณะของการเปรียบเทียบ
ค. ทําให้ดูน่าสนใจและทําให้ผู้ใช้ข้อมูลเข้าใจความหมายได้ง่ายข้ึน
ง. ช่วยในการนําเสนอข้อมูลท่ียุ่งยากสลับซับซ้อน
จ. ถูกทุกข้อ

10. ข้อใดเป็นชุดคําสั่งย่อยในการสร้างแผนภูมิ

ก.

ข.

ค.

ง.

จ.



เฉลยข้อสอบ

ข้อ
ท่ี

เฉลย

เฉลยข้อ ก. PivotTable (ตารางข้อมูล PivotTable)
คําอธิบาย แท็บ Options (ตัวเลือก) ประกอบด้วยกลุ่มคําส่ัง 9 กลุ่ม

กลุ่มท่ี 1.1 PivotTable (ตารางข้อมูล PivotTable)

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
1 Pivot Table Name ชื่อ PivotTable
2 options ตัวเลือก

เฉลยข้อ จ. Data (ข้อมูล)
คําอธิบาย แท็บ Options (ตัวเลือก) ประกอบด้วยกลุ่มคําส่ัง 9 กลุ่ม

กลุ่มท่ี 1.5 Data (ข้อมูล)

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
13 Refresh (Alt+F5) รีเฟรช
14 Change Data Source เปลี่ยนแหล่งข้อมูล

เฉลยข้อ ค. Tools (เครื่องมือ)
คําอธิบาย แท็บ Options (ตัวเลือก) ประกอบด้วยกลุ่มคําส่ัง 9 กลุ่ม

กลุ่มท่ี 1.8 Tools (เครื่องมือ)

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
21 PivotChart สร้างแผนภูมิ PivotTable



22 Recommended PivotTable PivotTable ท่ีแนะนํา

เฉลยข้อ ง. ตําแหน่ง
คําอธิบาย ส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูล

เมื่อมีการสร้างตาราง PivotTable จะปรากฏกรอบของการทํางานในหน้าต่าง PivotTable
แบ่งออกเป็น 2 ส่วนหลัก ๆ ด้วยกัน ดังนี้

1. Layout PivotTable (เค้าโครงรายงาน PivotTable) เป็นพื้นที่ในการสร้างรายงาน
สรุปผล รายงาน PivotTable โดยการเลือกชุดของข้อมูลหน้าต่างทางด้านขวามือ

2. PivotTable Field List (รายงานเขตข้อมูลของ PivotTable) ซ่ึงประกอบด้วย
- Choose fields to add to report : เลือกเซลล์ข้อมูลเพื่อเพิ่มลงในรายการ
- Drag fields between areas below : ลากเซลล์ข้อมูลไปมาระหว่างพื้นท่ีด้านล่าง

• Report Filter : ตัวกรองรายงาน
• Column Labels : ป้ายชื่อคอลัมน์
• Row Labels : ป้ายชื่อแถว
• Values : ค่าของข้อมูล

- Defer Layout Update : เลือกเวลาการปรับปรุง
เฉลยข้อ ข. แทรก (Insert) > PivotTable
คําอธิบาย การสร้างตารางวิเคราะห์ข้อมูล เป็นการวิเคราะห์ข้อมูลเพ่ือหาผลสรุปของข้อมูล ในท่ีนี้
จะสร้าง ตารางข้อมูลเพ่ือใช้อ้างอิงดังนี้



การสร้างตารางวิเคราะห์ข้อมูลสามารถปฏิบัติได้ดังนี้
1. คลิกเลือกท่ีเซลล์ใดเซลล์หนึ่งในตารางข้อมูล
2. คลิกที่แท็บ Insert (แทรก) เลือกคําส่ัง PivotTable (ตารางวิเคราะห์ข้อมูล) เลือกคําส่ัง

Pivot Table

จะปรากฏ Dialog Box ของ Create PivotTable (การสร้าง PivotTable) ซึ่งมีรายละเอียด
ดังนี้

- Choose the data that you want to analyze (เลือกข้อมูลท่ีต้องการวิเคราะห์)
- Select a table or range (เลือกตารางหรือช่วง)

Table/Range : ตาราง/ช่วงข้อมูล
- Use an external data source (ใช้แหล่งข้อมูลภายนอก)

Choose Connection : เลือกการเช่ือมต่อข้อมูลภายนอก
Connection name

- Choose where you want the PivotTable report to be placed (เลือกตําแหน่งที่
ต้องการวางรายงาน PivotTable)

- New Worksheet : วางในแผ่นงานใหม่
- Existing Worksheet : วางในแผ่นงานเดียวกับแหล่งข้อมูล
- Location : ตําแหน่งของ PivotTable
3. ในตัวอย่างน้ีให้เลือกวาง PivotTable ลงในแผ่นงานใหม่ เมื่อคลิก OK จะปรากฏ Dialog

box เค้าโครงรายงาน PivotTable ให้จัดตําแหน่งของ Field ต่าง ๆ โดยประกอบด้วยพื้นที่ 4 ส่วน
คือ Report Filter, Column Labels, RowLabels และ Values โดยให้คลิกลากที่ชื่อกลุ่มของ
ข้อมูล (Field) ไปวางตรงตําแหน่งท่ีต้องการ (ดังภาพ)



ผลลัพธ์ท่ีได้จากการสร้าง PivotTable เป็นดังภาพ

เฉลยข้อ ข. แทรก (Insert) > Slicer
คําอธิบาย การใช้งาน Slicer

Slicer เป็นคุณสมบัติที่เพิ่มขึ้นมาใน Microsoft Excel 2016 โดย Slicer มีลักษณะการ
ทํางานเช่นเดียวกันกับตัวกรองข้อมูล ข้อดีของ Slicer คือ การใช้งานที่สะดวกและรวดเร็วกว่าตัว
กรองข้อมูล การใช้งาน Slicer สามารถปฏิบัติได้ดังนี้

1. คลิกเลือกเซลล์ในตารางข้อมูล
2. คลิกเลือกคําสั่ง Insert ซ่ึงอยู่ในกลุ่ม Filters แล้วเลือก Slicer

จะปรากฏ dialog box ให้เลือก field ท่ีต้องการ ในตัวอย่างเป็นการเลือก field ตําแหน่ง



3. เม่ือคลิก OK จะปรากฏหน้าต่าง Slicer ข้ึน

จากรูปเป็นการใช้งาน Slicer เพ่ือกรองข้อมูล field ตําแหน่ง โดยเลือกเฉพาะตําแหน่ง
การเงิน ผู้จัดการ และเลขานุการ

4. ในการเลือก field ข้อมูลท่ีต้องการแสดงผลทําได้ดังนี้
- กรณีต้องการเลือกเพียง field เดียว สามารถทําได้โดยการคลิกท่ี field ท่ีต้องการ
- กรณีต้องการเลือกหลาย ๆ field ที่อยู่ติดกัน สามารถทําได้โดยคลิกเมาส์ค้างไว้แล้ว

ลากคลุม field ท่ีต้องการท้ังหมด
- กรณีต้องการเลือกหลาย ๆ field ที่ไม่อยู่ติดกัน สามารถทําได้โดยกดแป้นพิมพ์ Ctrl

ค้างไว้แล้วเลือก field ท่ีต้องการ
- กรณีต้องการยกเลิกการเลือก field ใด field หน่ึง สามารถทําได้โดยกดแป้นพิมพ์

Ctrl ค้างไว้แล้วเลือก field ท่ีต้องการยกเลิก

* กรณีต้องการยกเลิกการเลือก field ท้ังหมด สามารถทําได้โดยคลิกที่
เฉลยข้อ จ. ถูกทุกข้อ
คําอธิบาย การพยากรณ์ข้อมูลในโปรแกรม Microsoft Excel2016 เป็นการเปลี่ยนค่าตัวแปร
การสร้างตัวจัดการสถานการณ์สมมุติ และการค้นหาค่าเป้าหมายที่ต้องการ เพื่อนําข้อมูลมาใช้ใน
การตัดสินใจสําหรับการจัดการด้านธุรกิจ ซ่ึงเป็นการวิเคราะห์ข้อมูลเชิงเง่ือนไข
เฉลยข้อ ก. อัตราดอกเบี้ย
คําอธิบาย การค้นหาค่าเป้าหมายโดยการเปล่ียนตัวแปร (Goal Seek)

ฟังก์ชัน =PMT (rate,nper,pv, fv], [type) ช่วยในการคํานวณ
rate คือ อัตราดอกเบี้ย เป็นค่าท่ีต้องใส่เพื่อใช้ในการคํานวณ



nper คือ ระยะเวลาในการชําระเงิน เป็นค่าท่ีต้องใส่เพื่อใช้ในการคํานวณ
pv คือ มูลค่าของเงินในปัจจุบัน เป็นค่าท่ีต้องใส่เพื่อใช้ในการคํานวณ
[fv] คือ มูลค่าในอนาคต สามารถเลือกท่ีจะใส่หรือไม่ก็ได้ หากไม่ได้ใส่ข้อมูลไว้จะถือว่า

ค่า fV เป็น 0
[type] คือ กําหนดรูปแบบการผ่อนจ่าย โดยท่ี

กําหนดค่า 0 หมายถึงการผ่อนจ่ายเม่ือจบรอบเดือน
กําหนดค่า 1 หมายถึงการผ่อนจ่ายเม่ือเริ่มเดือน

เฉลยข้อ ข. ตารางข้อมูลเปรียบเทียบตัวแปรแบบ 2 ตัวแปร
คําอธิบาย การสร้างตารางข้อมูลเปรียบเทียบตัวแปร

การสร้างตารางข้อมูล (Data Table) เพื่อต้องการเปรียบเทียบค่าตัวแปรต่าง ๆ ที่เกี่ยวข้อง
กับข้อมูลหลาย ๆ ตัว ผลลัพธ์ท่ีได้จากการคํานวณจะช่วยในการตัดสินใจ ซ่ึงสามารถจัดการได้ดังนี้

การสร้างตารางข้อมูลเปรียบเทียบตัวแปรหนึ่งตัวแปร
การสร้างตารางข้อมูลเปรียบเทียบตัวแปร ตัวอย่างในกรณีของนางอุษา หากต้องการทราบว่า

จะต้องผ่อนชําระค่าอาคารชุดเดือนละเท่าใด หากอัตราดอกเบี้ยเปลี่ยนแปลงไป
การสร้างตารางข้อมูลเปรียบเทียบตัวแปรสองตัวแปร
การสร้างตารางข้อมูลเปรียบเทียบตัวแปรสองตัวแปร คล้ายกับการสร้างตารางข้อมูล

เปรียบเทียบค่าตัวแปรตัวเดียว แต่จะมีการเปรียบเทียบตัวแปรเข้าไปอีกหน่ึงตัวแปร ทําให้สามารถ
วิเคราะห์ข้อมูลได้ พร้อม ๆ กัน ตัวอย่าง นายสมชายต้องการผ่อนชําระอาคารชุดโดยที่ราคาและ
อัตราดอกเบี้ยมีการเปลี่ยนแปลงได้
เฉลยข้อ จ. ถูกทุกข้อ
คําอธิบาย การสร้างตัวจัดการสถานการณ์สมมุติ

การสร้างตัวจัดการสถานการณ์สมมุติ (Scenario Manager) ใช้ในการวิเคราะห์ข้อมูลในเชิง
เง่ือนไข โดยการจําลองสถานการณ์ขึ้นมา เพื่อพยากรณ์ข้อมูลแต่ละตัวบนแผ่นงานที่จะนําไปใช้เป็น
ข้อมูลในการตัดสินใจ ในกรณีที่ผู้ใช้มีข้อมูลจํานวนมากและเปล่ียนแปลงตามสถานการณ์ต่าง ๆ ท่ี
เกิดขึ้น การสร้างตัวจัดการสถานการณ์สมมุติจะทําให้ตัวแปรเปลี่ยนไปแล้วนํามาเก็บไว้ใน
Scenario Manager เพื่อที่จะนําไปสร้างรายงานตัวจัดการสถานการณ์สมมุติต่อไป



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 9
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ช่ือหน่วยการเรียนรู้ การพยากรณ์ข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การพยากรณ์ข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.เครื่องมือในการจัดการตารางวิเคราะห์ข้อมูล
2.ส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูล
3.การสร้างตารางวิเคราะหข้์อมูล
4.การตกแต่งตารางวิเคราะห์ข้อมูล

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงการสร้างตารางวิเคราะหข้์อมูลโดยใช้โปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.อธิบายเครื่องมือในการจัดการตารางวิเคราะห์ข้อมูลได้
2.บอกส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูลได้
3.สร้างตารางวิเคราะห์ข้อมูลได้
4.ตกแต่งตารางวิเคราะห์ข้อมูลได้

5. สาระการเรียนรู้
1.เครื่องมือในการจัดการตารางวิเคราะห์ข้อมูล
2.ส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูล
3.การสร้างตารางวิเคราะหข้์อมูล
4.การตกแต่งตารางวิเคราะห์ข้อมูล

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้



คะแนน เกรด
0-49 0
50-54 1
55-59 1.5
60-64 2
65-69 2.5
70-74 3

75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่องของ
การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจเรียน
เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการสอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึงอะไร
มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล



2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้

9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 9 หน่วยที่ 9
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ช่ือหน่วยการเรียนรู้ การพยากรณ์ข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การพยากรณ์ข้อมูล

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
การสร้างตารางวิเคราะห์ข้อมูล (PivotTable) เป็นการวิเคราะห์เพื่อหาผลสรุปของข้อมูล โดยสามารถ ปรับ

มุมมองของข้อมูลใหม่ได้โดยผูใ้ชเ้พียงคลิกแล้วลาก เพื่อเปลีย่นตําแหน่งของหัวข้อต่าง ๆ ให้เหมาะสมมากขึน้ตาม
ความตอ้งการ
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้านการ
ใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงการสร้างตารางวิเคราะหข้์อมูลโดยใช้โปรแกรม Microsoft Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.อธิบายเครื่องมือในการจัดการตารางวิเคราะห์ข้อมูลได้
2.บอกส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูลได้
3.สร้างตารางวิเคราะห์ข้อมูลได้
4.ตกแต่งตารางวิเคราะห์ข้อมูลได้

5.เน้ือหาสาระ













6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 9 หน่วยที่ 9
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 17

ช่ือหน่วยการเรียนรู้ การพยากรณ์ข้อมูล
ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือ การพยากรณ์ข้อมูล

แบบฝึกหัด

1. ชื่อของ PivotTable อยู่ในกลุ่มคําสั่งใด
ก. PivotTable (ตารางข้อมูล PivotTable)
ข. Active Field (เขตข้อมูลท่ีใช้งานอยู่)
ค. Group (กลุ่ม)
ง. Filter (ตัวกรอง)
จ. Data (ข้อมูล)

2. การเปล่ียนแหล่งข้อมูล อยู่ในกลุ่มคําสั่งใด
ก. PivotTable (ตารางข้อมูล PivotTable)
ข. Active Field (เขตข้อมูลท่ีใช้งานอยู่)
ค. Group (กลุ่ม)
ง. Filter (ตัวกรอง)
จ. Data (ข้อมูล)

3. การสร้างแผนภูมิ PivotTable อยู่ในกลุ่มคําสั่งใด
ก. Actions (การกระทํา)
ข. Calculations (การคํานวณ)
ค. Tools (เครื่องมือ)
ง. Show (แสดง)
จ. Data (ข้อมูล)

4. จากภาพ ข้อใดคือข้อมูลท่ีต้องการนํามาแสดงในแนวคอลัมน์



ก. รหัสพนักงาน
ข. ชื่อ
ค. อายุงาน
ง. ตําแหน่ง
จ. เงินเดือน

5. การสร้างรายงาน PivotTable ควรเลือกใช้คําสั่งในข้อใด
ก. หน้าแรก (Home) > PivotTable
ข. แทรก (Insert) > PivotTable
ค. ข้อมูล (Data) > PivotTable
ง. มุมมอง (Views) > PivotTable
จ. สูตร (Formulas) > PivotTable

6. ข้อใดเป็นคําสั่งในการใช้งาน Slicer
ก. หน้าแรก (Home) > Slicer
ข. แทรก (Insert) > Slicer
ค. ข้อมูล (Data) > Slicer
ง. มุมมอง (Views) > Slicer
จ. สูตร (Formulas) > Slicer

7. ข้อใดกล่าวได้ถูกต้องเก่ียวกับการพยากรณ์ข้อมูล
ก. เป็นการเปลี่ยนค่าตัวแปร
ข. การสร้างตัวจัดการสถานการณ์สมมุติ และการค้นหาค่าเป้าหมายท่ีต้องการ
ค. เป็นการนําข้อมูลมาใช้ในการตัดสินใจสําหรับการจัดการด้านธุรกิจ
ง. เป็นการวิเคราะห์ข้อมูลเชิงเง่ือนไข
จ. ถูกทุกข้อ

8. จากฟังก์ชัน =PMT (rate,nper,pv,[fv],[type]) ท่ีใช้ช่วยในการคํานวณ rate คืออะไร
ก. อัตราดอกเบี้ย



ข. ระยะเวลาในการชําระเงิน
ค. มูลค่าของเงินในปัจจุบัน
ง. มูลค่าในอนาคต
จ. กําหนดรูปแบบการผ่อนจ่าย

9. การคํานวณหาอัตราการชําระเงินต่องวดเพ่ือใช้ในการตัดสินใจกู้เงิน โดยมีอัตราดอกเบี้ยและเงินต้นท่ีแตกต่าง
กัน จะต้องวิเคราะห์ข้อมูลแบบใด

ก. ตารางข้อมูลเปรียบเทียบตัวแปรแบบ 1 ตัวแปร
ข. ตารางข้อมูลเปรียบเทียบตัวแปรแบบ 2 ตัวแปร
ค. การค้นหาค่าเป้าหมาย
ง. การสร้างรายงานสถานการณ์สมมติ
จ. การพยากรณ์โดยใช้ Regression Line

10. ข้อใดกล่าวได้ถูกต้องเก่ียวกับตัวจัดการสถานการณ์สมมติ (Scenario Manager)
ก. ใช้ในการวิเคราะห์ข้อมูลในเชิงเง่ือนไข โดยการจําลองสถานการณ์ขึ้นมา
ข. เป็นการพยากรณ์ข้อมูลแต่ละตัวบนแผ่นงาน ท่ีจะนําไปใช้เป็นข้อมูลในการตัดสินใจ
ค. ใชใ้นกรณีท่ีผู้ใช้มีข้อมูลจํานวนมากและเปลี่ยนแปลงตามสถานการณ์ต่าง ๆ ท่ีเกิดข้ึน
ง. การสร้างตัวจัดการสถานการณ์สมมุติจะทําให้ตัวแปรเปลี่ยนไปแล้วนํามาเก็บไว้ใน Scenario



เฉลยข้อสอบ

ข้อ
ท่ี

เฉลย

เฉลยข้อ ก. PivotTable (ตารางข้อมูล PivotTable)
คําอธิบาย แท็บ Options (ตัวเลือก) ประกอบด้วยกลุ่มคําส่ัง 9 กลุ่ม

กลุ่มท่ี 1.1 PivotTable (ตารางข้อมูล PivotTable)

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
1 Pivot Table Name ชื่อ PivotTable
2 options ตัวเลือก

เฉลยข้อ จ. Data (ข้อมูล)
คําอธิบาย แท็บ Options (ตัวเลือก) ประกอบด้วยกลุ่มคําส่ัง 9 กลุ่ม

กลุ่มท่ี 1.5 Data (ข้อมูล)

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
13 Refresh (Alt+F5) รีเฟรช
14 Change Data Source เปลี่ยนแหล่งข้อมูล

เฉลยข้อ ค. Tools (เครื่องมือ)
คําอธิบาย แท็บ Options (ตัวเลือก) ประกอบด้วยกลุ่มคําส่ัง 9 กลุ่ม

กลุ่มท่ี 1.8 Tools (เครื่องมือ)

หมายเลข คําส่ังภาษาอังกฤษ หน้าท่ีการทํางาน
21 PivotChart สร้างแผนภูมิ PivotTable



22 Recommended PivotTable PivotTable ท่ีแนะนํา

เฉลยข้อ ง. ตําแหน่ง
คําอธิบาย ส่วนประกอบหน้าต่างของตารางวิเคราะห์ข้อมูล

เมื่อมีการสร้างตาราง PivotTable จะปรากฏกรอบของการทํางานในหน้าต่าง PivotTable
แบ่งออกเป็น 2 ส่วนหลัก ๆ ด้วยกัน ดังนี้

1. Layout PivotTable (เค้าโครงรายงาน PivotTable) เป็นพื้นที่ในการสร้างรายงานสรุปผล
รายงาน PivotTable โดยการเลือกชุดของข้อมูลหน้าต่างทางด้านขวามือ

2. PivotTable Field List (รายงานเขตข้อมูลของ PivotTable) ซ่ึงประกอบด้วย
- Choose fields to add to report : เลือกเซลล์ข้อมูลเพื่อเพิ่มลงในรายการ
- Drag fields between areas below : ลากเซลล์ข้อมูลไปมาระหว่างพื้นท่ีด้านล่าง

• Report Filter : ตัวกรองรายงาน
• Column Labels : ป้ายชื่อคอลัมน์
• Row Labels : ป้ายชื่อแถว
• Values : ค่าของข้อมูล

- Defer Layout Update : เลือกเวลาการปรับปรุง
เฉลยข้อ ข. แทรก (Insert) > PivotTable
คําอธิบาย การสร้างตารางวิเคราะห์ข้อมูล เป็นการวิเคราะห์ข้อมูลเพื่อหาผลสรุปของข้อมูล ในที่นี้จะ
สร้าง ตารางข้อมูลเพ่ือใช้อ้างอิงดังนี้



การสร้างตารางวิเคราะห์ข้อมูลสามารถปฏิบัติได้ดังนี้
1. คลิกเลือกท่ีเซลล์ใดเซลล์หนึ่งในตารางข้อมูล
2. คลิกท่ีแท็บ Insert (แทรก) เลือกคําสั่ง PivotTable (ตารางวิเคราะห์ข้อมูล) เลือกคําสั่ง

Pivot Table

จะปรากฏ Dialog Box ของ Create PivotTable (การสร้าง PivotTable) ซึ่งมีรายละเอียด
ดังนี้

- Choose the data that you want to analyze (เลือกข้อมูลท่ีต้องการวิเคราะห์)
- Select a table or range (เลือกตารางหรือช่วง)

Table/Range : ตาราง/ช่วงข้อมูล
- Use an external data source (ใช้แหล่งข้อมูลภายนอก)

Choose Connection : เลือกการเช่ือมต่อข้อมูลภายนอก
Connection name

- Choose where you want the PivotTable report to be placed (เลือกตําแหน่ง ท่ี
ต้องการวางรายงาน PivotTable)

- New Worksheet : วางในแผ่นงานใหม่
- Existing Worksheet : วางในแผ่นงานเดียวกับแหล่งข้อมูล
- Location : ตําแหน่งของ PivotTable
3. ในตัวอย่างนี้ให้เลือกวาง PivotTable ลงในแผ่นงานใหม่ เม่ือคลิก OK จะปรากฏ Dialog

box เค้าโครงรายงาน PivotTable ให้จัดตําแหน่งของ Field ต่าง ๆ โดยประกอบด้วยพื้นที่ 4 ส่วน
คือ Report Filter, Column Labels, RowLabels และ Values โดยให้คลิกลากที่ชื่อกลุ่มของข้อมูล
(Field) ไปวางตรงตําแหน่งท่ีต้องการ (ดังภาพ)



ผลลัพธ์ท่ีได้จากการสร้าง PivotTable เป็นดังภาพ

เฉลยข้อ ข. แทรก (Insert) > Slicer
คําอธิบาย การใช้งาน Slicer

Slicer เป็นคุณสมบัติที่ เพิ่มขึ้นมาใน Microsoft Excel 2016 โดย Slicer มีลักษณะการ
ทํางานเช่นเดียวกันกับตัวกรองข้อมูล ข้อดีของ Slicer คือ การใช้งานที่สะดวกและรวดเร็วกว่าตัวกรอง
ข้อมูล การใช้งาน Slicer สามารถปฏิบัติได้ดังนี้

1. คลิกเลือกเซลล์ในตารางข้อมูล
2. คลิกเลือกคําสั่ง Insert ซ่ึงอยู่ในกลุ่ม Filters แล้วเลือก Slicer

จะปรากฏ dialog box ให้เลือก field ท่ีต้องการ ในตัวอย่างเป็นการเลือก field ตําแหน่ง



3. เม่ือคลิก OK จะปรากฏหน้าต่าง Slicer ข้ึน

จากรูปเป็นการใช้งาน Slicer เพื่อกรองข้อมูล field ตําแหน่ง โดยเลือกเฉพาะตําแหน่งการเงิน
ผู้จัดการ และเลขานุการ

4. ในการเลือก field ข้อมูลท่ีต้องการแสดงผลทําได้ดังนี้
- กรณีต้องการเลือกเพียง field เดียว สามารถทําได้โดยการคลิกท่ี field ท่ีต้องการ
- กรณีต้องการเลือกหลาย ๆ field ท่ีอยู่ติดกัน สามารถทําได้โดยคลิกเมาส์ค้างไว้แล้ว

ลากคลุม field ท่ีต้องการท้ังหมด
- กรณีต้องการเลือกหลาย ๆ field ที่ไม่อยู่ติดกัน สามารถทําได้โดยกดแป้นพิมพ์ Ctrl

ค้างไว้แล้วเลือก field ท่ีต้องการ
- กรณีต้องการยกเลิกการเลือก field ใด field หน่ึง สามารถทําได้โดยกดแป้นพิมพ์

Ctrl ค้างไว้แล้วเลือก field ท่ีต้องการยกเลิก

* กรณีต้องการยกเลิกการเลือก field ท้ังหมด สามารถทําได้โดยคลิกที่
เฉลยข้อ จ. ถูกทุกข้อ
คําอธิบาย การพยากรณ์ข้อมูลในโปรแกรม Microsoft Excel2016 เป็นการเปล่ียนค่าตัวแปร การ
สร้างตัวจัดการสถานการณ์สมมุติ และการค้นหาค่าเป้าหมายที่ต้องการ เพ่ือนําข้อมูลมาใช้ในการ
ตัดสินใจสําหรับการจัดการด้านธุรกิจ ซ่ึงเป็นการวิเคราะห์ข้อมูลเชิงเง่ือนไข
เฉลยข้อ ก. อัตราดอกเบี้ย
คําอธิบาย การค้นหาค่าเป้าหมายโดยการเปล่ียนตัวแปร (Goal Seek)

ฟังก์ชัน =PMT (rate,nper,pv, fv], [type) ช่วยในการคํานวณ
rate คือ อัตราดอกเบี้ย เป็นค่าท่ีต้องใส่เพื่อใช้ในการคํานวณ



nper คือ ระยะเวลาในการชําระเงิน เป็นค่าท่ีต้องใส่เพื่อใช้ในการคํานวณ
pv คือ มูลค่าของเงินในปัจจุบัน เป็นค่าท่ีต้องใส่เพื่อใช้ในการคํานวณ
[fv] คือ มูลค่าในอนาคต สามารถเลือกท่ีจะใส่หรือไม่ก็ได้ หากไม่ได้ใส่ข้อมูลไว้จะถือว่า

ค่า fV เป็น 0
[type] คือ กําหนดรูปแบบการผ่อนจ่าย โดยท่ี

กําหนดค่า 0 หมายถึงการผ่อนจ่ายเม่ือจบรอบเดือน
กําหนดค่า 1 หมายถึงการผ่อนจ่ายเม่ือเริ่มเดือน

เฉลยข้อ ข. ตารางข้อมูลเปรียบเทียบตัวแปรแบบ 2 ตัวแปร
คําอธิบาย การสร้างตารางข้อมูลเปรียบเทียบตัวแปร

การสร้างตารางข้อมูล (Data Table) เพ่ือต้องการเปรียบเทียบค่าตัวแปรต่าง ๆ ที่เกี่ยวข้องกับ
ข้อมูลหลาย ๆ ตัว ผลลัพธ์ท่ีได้จากการคํานวณจะช่วยในการตัดสินใจ ซ่ึงสามารถจัดการได้ดังนี้

การสร้างตารางข้อมูลเปรียบเทียบตัวแปรหนึ่งตัวแปร
การสร้างตารางข้อมูลเปรียบเทียบตัวแปร ตัวอย่างในกรณีของนางอุษา หากต้องการทราบว่า

จะต้องผ่อนชําระค่าอาคารชุดเดือนละเท่าใด หากอัตราดอกเบี้ยเปลี่ยนแปลงไป
การสร้างตารางข้อมูลเปรียบเทียบตัวแปรสองตัวแปร
การสร้างตารางข้อมูลเปรียบเทียบตัวแปรสองตัวแปร คล้ายกับการสร้างตารางข้อมูล

เปรียบเทียบค่าตัวแปรตัวเดียว แต่จะมีการเปรียบเทียบตัวแปรเข้าไปอีกหน่ึงตัวแปร ทําให้สามารถ
วิเคราะห์ข้อมูลได้ พร้อม ๆ กัน ตัวอย่าง นายสมชายต้องการผ่อนชําระอาคารชุดโดยที่ราคาและอัตรา
ดอกเบี้ยมีการเปลี่ยนแปลงได้
เฉลยข้อ จ. ถูกทุกข้อ
คําอธิบาย การสร้างตัวจัดการสถานการณ์สมมุติ

การสร้างตัวจัดการสถานการณ์สมมุติ (Scenario Manager) ใช้ในการวิเคราะห์ข้อมูลในเชิง
เง่ือนไข โดยการจําลองสถานการณ์ขึ้นมา เพื่อพยากรณ์ข้อมูลแต่ละตัวบนแผ่นงานที่จะนําไปใช้เป็น
ข้อมูลในการตัดสินใจ ในกรณีที่ผู้ใช้มีข้อมูลจํานวนมากและเปล่ียนแปลงตามสถานการณ์ต่าง ๆ ท่ี
เกิดข้ึน การสร้างตัวจัดการสถานการณ์สมมุติจะทําให้ตัวแปรเปล่ียนไปแล้วนํามาเก็บไว้ใน Scenario
Manager เพื่อที่จะนําไปสร้างรายงานตัวจัดการสถานการณ์สมมุติต่อไป



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..



แผนการจัดการเรียนรู้ หน่วยที่ 10
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่18
ช่ือหน่วยการเรียนรู้ การใช้คําส่ังแมโครและการพิมพ์เอกสารออก
ทางเครื่องพิมพ์

ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การใช้คําส่ังแมโครและการพิมพ์เอกสารออกทางเคร่ืองพิมพ์

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
1.การพิมพ์เอกสารออกทางเครื่องพิมพ์
2.การกําหนดหน้ากระดาษ

2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ
สมรรถนะย่อย -
1) เกณฑ์การปฏิบัติงาน
2) วิธีประเมิน
3) หลักฐานการปฏิบัติงาน (Performance Evidence)
4) หลักฐานความรู้ (Knowledge Evidence)
2.2 บูรณาการกลุ่มอาชีพ -

3. สมรรถนะประจําหน่วย
แสดงการใช้คําส่ังแมโครในการพิมพ์เอกสาร โดยใช้โปรแกรม Microsoft Excel 2016

4. จุดประสงค์เชิงพฤติกรรม
1.พิมพ์เอกสารออกทางเครื่องพิมพ์ได้
2.กําหนดหน้ากระดาษได้

5. สาระการเรียนรู้
1.การพิมพ์เอกสารออกทางเครื่องพิมพ์
2.การกําหนดหน้ากระดาษ

6. กิจกรรมการเรียนรู้
1 ข้ันนําเข้าสู่บทเรียน (Motivation)

1. ผู้สอนแจ้งหลักเกณฑ์การเก็บคะแนน วิธีวัดผลและประเมินผลให้แก่ผู้เรียนดังนี้
คะแนนงาน 40 คะแนน
สอบกลางภาค 20 คะแนน
จิตพิสัย 10 คะแนน
ปลายภาค 30 คะแนน
โดยมีหลักเกณฑ์ การวัดผลดังนี้
คะแนน เกรด
0-49 0
50-54 1
55-59 1.5
60-64 2
65-69 2.5



70-74 3
75-79 3.5
80 เป็นต้นไป 4

2. แนะนําการเรียนการสอน จุดประสงค์รายวิชาการอนุรักษ์ธรรมชาติและสิ่งแวดล้อมในโรงแรม
สมรรถนะรายวิชา คําอธิบายรายวิชา การวัดผลและประเมินผลพร้อมท้ังบรรยายเนื้อหาในเรื่อง
ของการอนุรักษ์ธรรมชาติและส่ิงแวดล้อมในโรงแรม

3. ผู้สอนอบรมสั่งสอนเก่ียวกับหน้าที่ความรับผิดชอบของนักเรียนท่ีต้องรู้จักการตรงต่อเวลา ตั้งใจ
เรียน เคารพซ่ึงกันและกัน ทําหน้าท่ีของนักเรียนท่ีดี พร้อมทั้งแจ้งกฎระเบียบในการเรียนการ
สอน

4. ผู้สอนสอบถามผู้เรียนว่า ตามความคิดของผู้เรียน การอนุรักษ์ธรรมชาติและสิ่งแวดล้อมหมายถึง
อะไร มีความสําคัญอย่างไรบ้าง

7.การวัดผลและประเมินผล

วิธีวัดผล
1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้ แบบฝึกปฏิบัติ
4. ตรวจใบงาน

เครื่องมือวัดผล
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้ และแบบฝึกปฏิบัติ
3. แบบประเมินกิจกรรมใบงาน

เกณฑ์การประเมินผล
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน และแบบฝึกปฏิบัติ 50%
3. แบบประเมินกิจกรรมใบงานมีเกณฑ์ผ่าน 50%

8. หลักฐานการเรียนรู้
8.1 หลักฐานความรู้

1. บันทึกการสอน
2. ใบเช็กรายช่ือ

8.2 หลักฐานการปฏิบัติงาน
1. แผนจัดการเรียนรู้

9. การวัดและประเมินผล
9.1 เกณฑ์การปฏิบัติงาน

1. สังเกตพฤติกรรมรายบุคคล
2. ตรวจกิจกรรมส่งเสริมคุณธรรมนําความรู้
3. ตรวจแบบประเมินผลการเรียนรู้

9.2 วิธีการประเมิน
1. แบบสังเกตพฤติกรรมรายบุคคล
2. แบบประเมินผลการเรียนรู้



9.3 เครื่องมือประเมิน
1. เกณฑ์ผ่านการสังเกตพฤติกรรมรายบุคคล ต้องไม่มีช่องปรับปรุง
2. แบบประเมินผลการเรียนรู้มีเกณฑ์ผ่าน 50%

10. บันทึกผลหลังการจัดการเรียนรู้
10.1 ข้อสรุปหลังการจัดการเรียนรู้

10.2 ปัญหาที่พบ

10.3 แนวทางแก้ปัญหา



ใบความรู้ 10 หน่วยที่ 10
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 18
ช่ือหน่วยการเรียนรู้ การใช้คําส่ังแมโครและการพิมพ์เอกสารออก
ทางเครื่องพิมพ์

ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือง/งาน การใช้คําส่ังแมโครและการพิมพ์เอกสารออกทางเคร่ืองพิมพ์

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน
การใช้งานคําสั่งท่ีมีการใช้บ่อย ๆ ซึ่งอาจต้องทําหลายขั้นตอน เพื่อเป็นการลดเวลาการทํางาน

โปรแกรมจึงสร้างชุดคําสั่งท่ีรวบรวมข้ันตอนการทํางานไว้ด้วยกัน โดยการใช้คีย์ลัดหรือใช้การเลือกคําสั่งเพียง
ขั้นตอนเดียวเรียกว่า แมโคร การพิมพ์ข้อมูลบนแผน่งานออกทางเคร่ืองพิมพ์เพื่อจัดเก็บไว้เปน็หลักฐานในการ
อ้างอิงในการทํางาน ก่อนจะส่ังพิมพ์ข้อมูลออกทางเคร่ืองพิมพ์ควรตัง้ค่าต่าง ๆ ไมว่่าจะเป็นขอบกระดาษ แนว
กระดาษ ขนาดกระดาษ เพื่อให้รายงานออกมาสวยงามและเป็นไปตามที่ผู้ใช้ต้องการ
2. อ้างอิงมาตรฐาน/เช่ือมโยงกลุ่มอาชีพ

มาตรฐานคุณวุฒิวิชาชีพ สถาบันคุณวุฒิวิชาชีพ (องค์การมหาชน) สมรรถนะสนับสนุนการทํางานด้าน
การใช้ดิจิทัล ระดับ 2 และระดับ 3
3. สมรรถนะประจําหน่วย

แสดงการใช้คําส่ังแมโครในการพิมพ์เอกสาร โดยใช้โปรแกรม Microsoft Excel 2016
4. จุดประสงค์เชิงพฤติกรรม

1.พิมพ์เอกสารออกทางเครื่องพิมพ์ได้
2.กําหนดหน้ากระดาษได้

5.เน้ือหาสาระ













6. แบบฝึกหัด/แบบทดสอบ
แบบทดสอบหลังเรียน
7. เอกสารอ้างอิง (ข้ึนหน้าใหม่)

หนังสือเรียนวิชาโปรแกรมตารางคํานวณ
8. ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ)
เฉลยบบฝึกหัด



ใบงาน ท่ี 10 หน่วยที่ 10
รหัสวิชา 21910-2005 ช่ือวิชา โปรแกรมตารางคํานวณ สอนครั้งที่ 18
ช่ือหน่วยการเรียนรู้ การใช้คําส่ังแมโครและการพิมพ์เอกสารออก
ทางเครื่องพิมพ์

ทฤษฎี 1 ชม.
ปฏิบัติ 2 ชม.

ช่ือเร่ือ การใช้คําส่ังแมโครและการพิมพ์เอกสารออกทางเครื่องพิมพ์

แบบฝึกหัด
1. การสร้างตางรางข้อมูลเปรียบเทียบตัวแปรสามารถวิเคราะห์ข้อมูลได้กี่แบบ

ก. 1 แบบ
ข. 2 แบบ
ค. 3 แบบ
ง. 4 แบบ
จ. 5 แบบ

2. แมโคร (Macro) คืออะไร
ก. เป็นการสร้างตารางการวิเคราะห์เพ่ือหาผลสรุปของข้อมูล
ข. เป็นการสร้างคําสั่งในการพยากรณ์ข้อมูล
ค. เป็นการสร้างชุดคําสั่งอัตโนมัติ
ง. ถูกท้ัง ก และ ข
จ. ถูกท้ัง ก ข และ ค

3. ข้อใดเป็นคําสั่งท่ีใช้ในการบันทึกแมโคร
ก. Home > Macro > Record Macro…
ข. Insert > Macro > Record Macro…
ค. Design > Macro > Record Macro…
ง. View > Macro > Record Macro…
จ. Data > Macro > Record Macro…

4. ข้อใดเป็นคําสั่งในการสั่งพิมพ์เอกสารออกทางเครื่องพิมพ์
ก. File > Print
ข. Home > Print
ค. Insert > Print
ง. Page Layout > Print
จ. Data > Print

5. เป็นคําส่ังในการกําหนดอะไร
ก. การกําหนดจํานวนสําเนา (Copies)
ข. การกําหนดเครื่องพิมพ์และตั้งค่าคุณสมบัติการพิมพ์ (Printer Properties)
ค. การตั้งพ้ืนที่การพิมพ์
ง. การกําหนดหน้ากระดาษท่ีพิมพ์



จ. การกําหนดขนาดกระดาษ (Properties)
6. ข้อใดเป็นการตั้งพื้นท่ีการพิมพ์

ก.

ข.

ค.

ง.

จ.

จากภาพ ใช้ตอบคําถามข้อ 97-98

7. หมายเลขใดเป็นการกําหนดขนาดของกระดาษ
ก. หมายเลข 1



ข. หมายเลข 2
ค. หมายเลข 3
ง. หมายเลข 4
จ. หมายเลข 5

8. หมายเลข 2 คืออะไร
ก. พิมพ์ข้อมูลในแนวตั้ง
ข. พิมพ์ข้อมูลในแนวนอน
ค. ปรับให้พอดี
ง. กําหนดขนาดของกระดาษ
จ. กําหนดคุณภาพของการพิมพ์

จากภาพ ใช้ตอบคําถามข้อ 99-100

9. หมายเลข 4 คืออะไร
ก. กําหนดระยะขอบบนกระดาษ
ข. กําหนดระยะขอบล่างกระดาษ
ค. กําหนดระยะด้านบนของข้อความหัวกระดาษ
ง. กําหนดระยะด้านล่างของข้อความท้ายกระดาษ
จ. กําหนดระยะขอบขวากระดาษ

10. หมายเลขใดเป็นการกําหนดข้อมูลให้อยู่ก่ึงกลางกระดาษในแนวนอน
ก. หมายเลข 4
ข. หมายเลข 5
ค. หมายเลข 6
ง. หมายเลข 7
จ. หมายเลข 8



เฉลยข้อสอบ

ข้อ
ท่ี

เฉลย

เฉลยข้อ ข. 2 แบบ
คําอธิบาย การสร้างตารางข้อมูลเปรียบเทียบตัวแปร

การสร้างตารางข้อมูล (Data Table) เพ่ือต้องการเปรียบเทียบค่าตัวแปรต่าง ๆ ที่เกี่ยวข้องกับ
ข้อมูลหลาย ๆ ตัว ผลลัพธ์ท่ีได้จากการคํานวณจะช่วยในการตัดสินใจ ซ่ึงสามารถจัดการได้ดังนี้

1. การสร้างตารางข้อมูลเปรียบเทียบตัวแปรหนึ่งตัวแปร
การสร้างตารางข้อมูลเปรียบเทียบตัวแปร ตัวอย่างในกรณีของนางอุษา หากต้องการทราบว่า

จะต้องผ่อนชําระค่าอาคารชุดเดือนละเท่าใด หากอัตราดอกเบี้ยเปลี่ยนแปลงไป
2. การสร้างตารางข้อมูลเปรียบเทียบตัวแปรสองตัวแปร
การสร้างตารางข้อมูลเปรียบเทียบตัวแปรสองตัวแปร คล้ายกับการสร้างตารางข้อมูล

เปรียบเทียบค่าตัวแปรตัวเดียว แต่จะมีการเปรียบเทียบตัวแปรเข้าไปอีกหน่ึงตัวแปร ทําให้สามารถ
วิเคราะห์ข้อมูลได้ พร้อม ๆ กัน ตัวอย่าง นายสมชายต้องการผ่อนชําระอาคารชุดโดยที่ราคาและอัตรา
ดอกเบี้ยมีการเปลี่ยนแปลงได้
เฉลยข้อ ค. เป็นการสร้างชุดคําสั่งอัตโนมัติ
คําอธิบาย Macro (แมโคร)

Macro (แมโคร) หมายถึง ชุดของคําส่ังที่ถูกรวบรวมเข้าไว้ด้วยกัน เพื่อลดขั้นตอนการทํางานท่ี
ซ้ํา ๆ กัน เช่น การลดเวลาในการป้อนหรือการพิมพ์ที่มีรูปแบบเหมือน ๆ กันได้เป็นอย่างดี คําสั่งแม
โครจะทําการบันทึกข้ันตอนการทํางานเก็บเอาไว้ และเรียกมาใช้งานได้อย่างรวดเร็วด้วยคีย์ลัดหรือปุ่ม
คําส่ังที่สร้างขึ้นมา เช่น การสร้างแบบฟอร์มที่ใช้งานบ่อย หรือรูปแบบรายงานที่เหมือนกันโดยไม่ต้อง
สร้างท่ีละแผ่นงาน

การสร้างแมโคร (Macro) คือ การสร้างชุดคําสั่งอัตโนมัติขึ้น ซึ่งเป็นคําสั่งที่จะต้องใช้งานบ่อย
ๆ หรือทํางานซ้ํา ๆ เพื่อเป็นการลดเวลาในการทํางาน เช่น การจัดรูปแบบตัวอักษร การกําหนดขนาด
ตัวอักษร การกําหนดสีตัวอักษร และการจัดรูปแบบแผ่นงาน
เฉลยข้อ ง. View > Macro > Record Macro…
คําอธิบาย วิธีการบันทึกแมโคร

1. คลิกท่ีเซลล์ท่ีต้องการหรือเซลล์ใด ๆ ในตารางข้อมูล
2. คลิกท่ีแท็บ View (มุมมอง) เลือกคําสั่ง Macros (แมโคร)
3. คลิกเลือกคํา ส่ัง Record Macro.. (บันทึกแมโคร..) หรือเ ลือกคําสั่ ง Use Relative

References บันทึกคําสั่งแมโครแบบสัมพัทธ์



4. จะปรากฏ Dialog Box มีรายละเอียดประกอบดังนี้
Macro name : กําหนดช่ือแมโคร
Shortcut key : กําหนดคีย์ลัดเพ่ือเรียกใช้แมโคร (โดยการกําหนดตัวอักษร

ลงในช่องท่ีกําหนด ใช้ร่วมกับปุ่ม Ctrl หรือปุ่ม Ctrl + Shift)
Store macro in : กําหนดการเก็บคําสั่งแมโครไว้ท่ีส่วนใด
Personal Macro Workbook : สมุดงานแมโครส่วนบุคคล
New Workbook : สมุดงานใหม่
This Workbook : สมุดงานเดิมท่ีเปิดอยู่
Description : คําอธิบายคําส่ังแมโคร
5. คลิก OK เพื่อเริ่มบันทึกแมโคร
6. เมื่อบันทึกแมโครเรียบร้อยแล้วให้คลิกหยุดบันทึกที่ คลิกที่แท็บ View (มุมมอง) เลือกคําสั่ง

Macros (แมโคร) จะปรากฏแถบเคร่ืองมือของ Stop Recording (หยุดการบันทึก) คลิกที่ Stop
(หยุดบันทึก) เพื่อบอกให้โปรแกรมหยุดการบันทึก

หมายเหตุ หรือสามารถคลิกท่ีคําสั่งหยุดบันทึกแถบสถานะ (Status bar)

7. บันทึกสมุดงานโดยไปที่เมนู File > Save as ตั้งช่ือสมุดงานที่ File name และกําหนด
Save as types เป็น Excel Macro-Enabled Workbook



ไฟล์สมุดงานท่ีบันทึกคําสั่งแมโคร Macro-Enabled Workbook

เฉลยข้อ ก. File > Print
คําอธิบาย การพิมพ์เอกสารออกทางเครื่องพิมพ์

การพิมพ์เอกสารออกทางเครื่องพิมพ์คลิกเลือกท่ีเมนู File > Print หรือกดคีย์ลัด Ctrl + P
หรือคลิกที่ไอคอน บนแถบ Quick Access Toolbar จะปรากฏหน้าต่างการตั้งค่าการพิมพ์และ
หน้าต่างแสดงงานที่จะพิมพ์

เฉลยข้อ ก. การกําหนดจํานวนสําเนา (Copies)
คําอธิบาย



เป็นการกําหนดจํานวนสําเนา (Copies) ว่าต้องการพิมพ์เอกสารจํานวนก่ี
ชุด
เฉลยข้อ ก.

คําอธิบาย การตั้งพ้ืนที่การพิมพ์
Print Active Sheets : พิมพ์แผ่นงานท่ีใช้งานอยู่
Print Entire Workbook : พิมพ์ท้ังสมุดงาน
Print Selection : พิมพ์เฉพาะส่วนท่ีเลือก

เฉลยข้อ จ. หมายเลข 5
คําอธิบาย การกําหนดหน้ากระดาษ

ข้อมูลที่ต้องส่ังพิมพ์ออกทางเคร่ืองพิมพ์ จะต้องต้ังค่าหน้ากระดาษเพื่อให้งานที่พิมพ์ออกทาง
เคร่ืองพิมพ์เหมาะสมกับขนาดของกระดาษ การต้ังค่าหน้ากระดาษให้กับแผ่นงาน สามารถปฏิบัติได้
ดังนี้

1. คลิกเลือกแผ่นงานท่ีต้องการตั้งค่าหน้ากระดาษ จากนั้นคลิกที่แท็บ Page Layout (เค้า
โครง หน้ากระดาษ)

2. คลิกเลือกคําสั่ง Size (ขนาด) เลือก More Paper Sizes (ขนาดกระดาษเพิ่มเติม) หรือ
3. คลิกท่ี Page Setup (ต้ังค่าหน้ากระดาษ) จะปรากฏ Dialog Box ของ Page Setup (ต้ังค่า

หน้ากระดาษ)
4. คลิกเลือกแท็บ Page (หน้า)

รายละเอียดของการกําหนดกระดาษ (Page)



Orientation : กําหนดการวางแนวของกระดาษ
Portrait : พิมพ์ข้อมูลในแนวตั้ง
Landscape : พิมพ์ข้อมูลในแนวนอน
Scaling : กําหนดมาตราส่วนการพิมพ์
Adjust to : ปรับย่อ/ขยายแผ่นงานเป็นเปอร์เซ็นต์
Fit to : ปรับให้พอดี
Paper size : กําหนดขนาดของกระดาษ
Print quality : กําหนดคุณภาพของการพิมพ์
First page number : กําหนดหมายเลขหน้า

5. คลิก OK
เฉลยข้อ ข. พิมพ์ข้อมูลในแนวนอน
คําอธิบาย การกําหนดหน้ากระดาษ

ข้อมูลที่ต้องส่ังพิมพ์ออกทางเคร่ืองพิมพ์ จะต้องต้ังค่าหน้ากระดาษเพื่อให้งานที่พิมพ์ออกทาง
เคร่ืองพิมพ์เหมาะสมกับขนาดของกระดาษ การต้ังค่าหน้ากระดาษให้กับแผ่นงาน สามารถปฏิบัติได้
ดังนี้

1. คลิกเลือกแผ่นงานท่ีต้องการตั้งค่าหน้ากระดาษ จากนั้นคลิกที่แท็บ Page Layout (เค้า
โครง หน้ากระดาษ)

2. คลิกเลือกคําสั่ง Size (ขนาด) เลือก More Paper Sizes (ขนาดกระดาษเพิ่มเติม) หรือ
3. คลิกท่ี Page Setup (ต้ังค่าหน้ากระดาษ) จะปรากฏ Dialog Box ของ Page Setup (ต้ังค่า

หน้ากระดาษ)
4. คลิกเลือกแท็บ Page (หน้า)

รายละเอียดของการกําหนดกระดาษ (Page)
Orientation : กําหนดการวางแนวของกระดาษ
Portrait : พิมพ์ข้อมูลในแนวตั้ง
Landscape : พิมพ์ข้อมูลในแนวนอน
Scaling : กําหนดมาตราส่วนการพิมพ์
Adjust to : ปรับย่อ/ขยายแผ่นงานเป็นเปอร์เซ็นต์
Fit to : ปรับให้พอดี
Paper size : กําหนดขนาดของกระดาษ
Print quality : กําหนดคุณภาพของการพิมพ์



First page number : กําหนดหมายเลขหน้า
5. คลิก OK

เฉลยข้อ ค. กําหนดระยะด้านบนของข้อความหัวกระดาษ
คําอธิบาย การกําหนดขอบกระดาษ (Margins)

การกําหนดขอบกระดาษเป็นการกําหนดระยะจากขอบกระดาษกับข้อมูลบนแผ่นงานเพ่ือให้
ข้อมูล อยู่ในรูปแบบที่สวยงามเหมาะสมกับกระดาษ ซ่ึงสามารถปฏิบัติได้ดังนี้

1. คลิกเลือกแผ่นงานท่ีต้องการตั้งค่าหน้ากระดาษ จากนั้นคลิกที่แท็บ Page Layout (เค้า
โครงหน้ากระดาษ)

2. คลิกเลือกคําสั่ง Margins (ระยะขอบ) เลือก ระยะขอบแบบกําหนดเอง

3. จะปรากฏ Dialog Box

4. คลิกเลือกแท็บ Margins (ระยะขอบ) โดยกําหนดระยะขอบกระดาษ ซ่ึงจะมีรายละเอียด
ดังนี้

- Top : กําหนดระยะขอบบนกระดาษ
- Left : กําหนดระยะขอบซ้ายกระดาษ
- Right : กําหนดระยะขอบขวากระดาษ
- Bottom : กําหนดระยะขอบล่างกระดาษ
- Header : กําหนดระยะด้านบนของข้อความหัวกระดาษ
- Footer : กําหนดระยะด้านล่างของข้อความท้ายกระดาษ
- Center on page : กําหนดวางข้อมูลบนกระดาษ



- Horizontally : กําหนดข้อมูลให้อยู่ก่ึงกลางกระดาษในแนวนอน
- Vertically : กําหนดข้อมูลให้อยู่ก่ึงกลางกระดาษในแนวตั้ง

5. เม่ือกําหนดเรียบร้อยแล้วคลิก OK
เฉลยข้อ ง. หมายเลข 7
คําอธิบาย การกําหนดขอบกระดาษ (Margins)

การกําหนดขอบกระดาษเป็นการกําหนดระยะจากขอบกระดาษกับข้อมูลบนแผ่นงานเพ่ือให้
ข้อมูล อยู่ในรูปแบบที่สวยงามเหมาะสมกับกระดาษ ซ่ึงสามารถปฏิบัติได้ดังนี้

1. คลิกเลือกแผ่นงานท่ีต้องการตั้งค่าหน้ากระดาษ จากนั้นคลิกที่แท็บ Page Layout (เค้า
โครงหน้ากระดาษ)

2. คลิกเลือกคําสั่ง Margins (ระยะขอบ) เลือก ระยะขอบแบบกําหนดเอง หรือ

3. คลิกท่ี Page Setup (ตั้งค่าหน้ากระดาษ) จะปรากฏ Dialog Box

4. คลิกเลือกแท็บ Margins (ระยะขอบ) โดยกําหนดระยะขอบกระดาษ ซ่ึงจะมีรายละเอียด
ดังนี้

- Top : กําหนดระยะขอบบนกระดาษ
- Left : กําหนดระยะขอบซ้ายกระดาษ
- Right : กําหนดระยะขอบขวากระดาษ
- Bottom : กําหนดระยะขอบล่างกระดาษ
- Header : กําหนดระยะด้านบนของข้อความหัวกระดาษ
- Footer : กําหนดระยะด้านล่างของข้อความท้ายกระดาษ



- Center on page : กําหนดวางข้อมูลบนกระดาษ
- Horizontally : กําหนดข้อมูลให้อยู่ก่ึงกลางกระดาษในแนวนอน
- Vertically : กําหนดข้อมูลให้อยู่ก่ึงกลางกระดาษในแนวตั้ง

5. เม่ือกําหนดเรียบร้อยแล้วคลิก OK



บันทึกหลังการสอน
1. ผลการจัดการเรียนรู้ตามแผนการสอน

1.1 วัน เดือน ปี ................สอนครั้งท่ี ........... สาขา/ชั้นปี ..................จํานวนผู้เรียน............คน
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน

1.2 หัวข้อเรื่อง/เนื้อหา สาระ : …………………….……………………...........................................................
 สอนครบตามหัวข้อเรื่องในแผนฯ  สอนไม่ครบเนื่องจาก.................................................

1.3 กิจกรรม/วิธีการสอน
 ครูแนะนําและบอกจุดประสงค์  ครูอธิบาย/ถาม-ตอบ/สาธิต/.
 ทําแบบทดสอบก่อนเรียน  ทําแบบทดสอบหลังเรียน
 ทําแบบฝึกหัด/โจทย์ปัญหา  ทําใบกิจกรรม/ใบงาน
 อื่นระบุ)....................................................................................................................................

1.4 สื่อการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………..……………………..
2. ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาท่ีพบ

2.1 การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ……………………………………….……………………
...........................................................................................................................................................................

2.2 สมรรถนะท่ีผู้เรียนได้รับ : ................................................................................................................
...........................................................................................................................................................................

2.3 สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..………………………………………………………………………
……………...............................................................................................................................................................

2.4 ผลการสอนของครู : ..………………………………………………………………….……………………………………..
……........................................................................................................................................................................

2.5 ปัญหาที่นําไปสู่การวิจัย :……………………………..……………………....….…………………………………………
……………...............................................................................................................................................................
3. แนวทางการพัฒนาคุณภาพการสอน

3.1 ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : ………………………………………………………………………….
……………...............................................................................................................................................................

3.2 แนวทางพัฒนาคุณภาพวิธีสอน/สื่อ/การวัดผล/เอกสารช่วยสอน
..............................................................................................................................................................................
……………………………………………………………………………………………………………………………………………………..
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